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About PDisp 1

1.2

About PDisp

General Program Description

PDisp Pressure Induced Displacement Analysis

PDisp calculates the displacements (and stresses if required) within a linear elastic or non-linear soil
mass, arising from uniform normal or tangential pressure, applied to rectangular, polygonal and
circular loaded planes.

PDisp also calculates time-rate 1D consolidation for linear problems using the finite difference
approach.

The program is ideal for predicting the displacements that may arise due to the action of several
loads in a soil mass.

PDisp is a development of (and replacement for) Vdisp. Vdisp predicted displacements induced by
vertical loads on horizontal loaded areas only. PDisp is capable of predicting displacements due to
both vertical and horizontal loads.

Components of the User Interface

The principal components of PDisp's user interface are the Gateway, Table Views, Graphical Input,
Plan View, Cross Sectional View, 3D Graphical Output, Text Output, toolbars, menus and input
dialogs. Some of these are illustrated below.

© Oasys Ltd. 2019
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1.3 Program Features

The main features of PDisp are summarised below.

e displacements are calculated using a profile of Young's modulus with depth. The modulus can
be constant or vary linearly with depth for each soil layer. Non-linear stress/strain curves may
also be specified.

e Displacements and stresses, and Time-rate 1D consolidation can be calculated at several
levels and at any location in plan. The location of the displacement/stress points is defined by
means of two-dimensional orthogonal grids, by lines or by points. The results from the grids can
be displayed graphically as contours .

e Loaded areas can be defined as rectangles, circles or polygons. Pressures are applied as
vertically and/or horizontally and uniformly distributed loads to rectangular and/or circular loaded
areas. Areas can be superimposed and placed at any lewvel. All loads are completely flexible i.e.
no allowance is made for stiffness of the structures.

¢ The base of the model is defined by the specification of an equivalent rigid boundary.

e The ground is modelled using a series of vertical soil profiles each consisting of a number of
horizontal soil layers. The plan distribution of the soil profiles is specified in rectangular areas
known as soil zones. These can be superimposed allowing the development of complicated
ground models.

No allowance is made for the effect of soil zoning on stress distribution.

© Oasys Ltd. 2019
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1.4

Loaded Area
I iy
. 57 ¥
tlaterial 1 / Displacement
[ Strain)
baterial 2
Pressure
" (Stress)
. E
Material 3 Profile
Figid boundary
X
INPUT OUTPUT

Sample Files

Sample files are provided during the installation process. These demonstrate PDisp's features. By
default they are installed in the folder 'C:\Program Files\Oasys\PDisp n\Samples', where n indicates
the version of the program. These files may be opened and inspected in PDisp in order to become
familiar with the typical input data that is required to create a PDisp model.

The sample files are named to indicate the features of the program that they demonstrate.

DXF files are also provided to demonstrate DXF import.

Methods of Analysis

General

Two methods of analysis for displacements due to loads are available in PDisp:

e Boussinesq
¢ Mindlin

The Boussinesq method has the advantage that it gives a report of stresses in the ground in addition
to displacement. In addition, it allows PDisp to perform Time-Rate consolidation. It has the
disadvantage, however, that the results are sensitive to the spacing of the number of intermediate
displacement lewels specified. The accuracy of the result can therefore be improved by introducing
more displacement levels. This is particularly true just beneath small loaded areas which are
carrying a significant load. If the distribution of settlement close to the load is important then the
vertical spacing of the displacement levels should be set so that they do not exceed 25% of the size
of the loaded area.

The Mindlin method only provides details of vertical and horizontal displacements and not stresses.

© Oasys Ltd. 2019
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2.2

221

Consolidation calculations cannot be performed if this method is selected. It predicts:

¢ \ertical displacements resulting from vertical loads;
¢ horizontal displacements resulting from vertical loads; and
¢ \ertical displacements resulting from horizontal loads.

The Mindlin method considers the effect of all the soil, above and below the load, acting elastically
when calculating vertical displacements. It is not sensitive to the spacing of intermediate
displacement lewels, unless there is a sharp gradient of stiffness, see Displacement Levels.

Boussinesq Analysis Method

The Boussinesq analysis method calculates the stresses in the strata due to the applied loads. The
method uses integrated forms of the well known equations derived by Boussinesq (1885). Strains
are calculated within the strata. Displacements are then defined by integrating vertical strains.

Stresses are calculated at points vertically beneath each intersection within a displacement grid
(see Displacement Data) and at the centre of each sub-layer, see Displacement Lewels.

Vertical displacements resulting from normal loads applied on horizontal planes only are calculated
in this method. The Mindlin method may be used to calculate horizontal displacements.

Determination of Stresses

The \ertical stress o, and the sum of principal stresses o, are calculated using the integrated
Boussinesq equations, with respect to x and y, over the area of a uniformly loaded rectangle.

L Loaded Area Certroid

>
/
i

where:
op =oX+oy toz
The general equations are:

3pz?
5, = Hzpmﬁ dydx

xy LT
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{1+wglpz
o= [ [ —=— dydx
F :{{r aR? !

R = distance between the centre of the loaded area and the stress evaluation point.
z = vertical distance from the loaded area to the stress evaluation point.

p = applied pressure on loaded area
Vv, = GLOBAL Poisson's ratio.

For this calculation it is assumed that Young's modulus and Poisson's ratio are constant throughout
the soil. This assumption is generally considered to give a satisfactory distribution of stress, but its
validity can be doubtful where stiff strata overlie softer ones.

The pressure loads can be specified as acting at different levels. If a stress evaluation point is above
an applied load, then no account of that load is made when determining the stresses at that point. In
other words the displacement at a point above a loaded area is equal to the displacement at the lewel
of the load.

2.2.2 Strains and Displacements

The \ertical strains, and thereby displacements, are calculated for each sub-layer at every stress
evaluation point. For this calculation local values of Young's modulus and Poisson's ratio are used.

The \ertical displacement, at each grid location, is calculated by summing the displacement of each
of the sub-layers from the rigid boundary up to the grid level. For information on the location of sub-
layers, see Displacement Lewels.

If a non-linear cune is specified for this stratum the program calculates the stiffness factor
appropriate to the final resulting value of strain (see Non-linear Materials).This stiffness factor is
multiplied by the appropriate Young's modulus to obtain the final stiffness value.

2.2.2.1 Global Poisson's Ratio

The use of the Boussinesg method of solution requires the user to specify a value of global Poisson's
ratio (vg) to enable the stress calculations to be made. In general the choice of an average value of

2 will not result in a significant error in the calculated displacements. The maximum expected error
in the calculated displacements, by a poor choice of Vg is only about 5 to 10%.

In certain circumstances, howewer, the selection of 2 is important. This is because although vy has
no effect on the calculated value of vertical stress (c,), it does affect the calculated mean stress S,
which is used to derive vertical strain (g, ):

By = %[[1+ vio, - wjp]

© Oasys Ltd. 2019
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2.2.2.2

An example of this is a short term analysis with interbedded granular and cohesive materials. The
cohesive layer(s) will have an undrained Poisson's ratio, Vg whilst the granular layer will have a

drained Poisson's ratio, v'. In this case the highest relevant value of Poisson's ratio (the undrained
value) should be entered as Vg Errors due to calculation of O, will be less in the layers of drained

granular material, than in the layers of undrained cohesive material if the drained value had been

substituted for Vg

In cases such as these it is advisable to use the Mindlin method of solution, or at least to carry out
a separate run to provide a check. This method does not generate these kind of errors.

Calculation Details

The determination of displacement for stress evaluation point 'i', at the centre of each sub-layer

proceeds as follows.

Young's modulus at " is:

e E-Ei)r o
Ei_Etm[zt )

Where

E, = Young's modulus at top of layer
E, = Young's modulus at base of layer
z = Lewel

The ertical strain of the sub-layer is
g, = %[[1+ o, - wjp]

v = Poisson's ratio of sub-layer

Where

o, = \ertical stress at the stress evaluation point

o, = sum of the principal stresses at the stress evaluation point

For non-linear soil curves PDisp calculates the corresponding stress change at 'i' where

o =&, E,

The appropriate stiffness, modified for this stress lewel, is then determined by linear interpolation of

the stress values corresponding to the strain values input by the user.

Vertical displacement within the sub-layer is then:

© Oasys Ltd. 2019
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B
By = [=y4dz

zi
Zhi

When E; = E,, this is approximated as:
Ba = 2ailZy — Zui]

When E,# E,
B =y [Eti - Zbi]

2.2.3 Accuracy of the Boussinesq Solution

The accuracy of the predicted settlement is influenced by the spacing of the stress evaluation points.
Decreasing the vertical distance between the points increases accuracy.

Large changes of stress or stiffness between adjacent points will lead to a reduction of accuracy.
Stress evaluation points should therefore also be closely spaced beneath and around localised loads
and where the variation of stiffness with depth is large.

For soils in which the Young's modulus (E) varies linearly with depth, additional sub-layers can be
generated automatically by specifying the maximum allowable ratio of E between adjacent stress
evaluation points. This ratio controls the maximum variation of E within each sub-layer.

The default ratio value is 1.5. It must be emphasised, howewer, that even with constant E the
accuracy of the Boussinesq solution is still a function of the number of sub-layers.

For further information see Young's modulus (E) and Displacement Lewels.

2.3 Mindlin Analysis Method

The Mindlin method calculates relative displacements across a stratum directly from the applied
loads. It calculates the displacements due to a vertical or horizontal load applied as a uniform stress
on a rectangular or circular area on or beneath the surface of a semi-infinite homogeneous, isotropic
and elastic half-space material. The method uses equations derived by Vaziri et al (1982) from the
work of Mindlin (1936) and does not calculate stresses.

A value for global Poisson's ratio is not required for the Mindlin calculation.

2.3.1 Mindlin and the Legacy Mindlin Method

The Legacy Mindlin method represents the Mindlin method of Pdisp versions 18.2 and earlier. It has
the following characteristics.

o Only wertical loads on horizontal planes are considered. Other load orientations are ignored.
o No consideration is given to the influence of ground above a vertical load when calculating
settlements at points below the load. That is, all loads are treated as though they are at the

© Oasys Ltd. 2019
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ground surface, so that soil above the load does not contribute to resisting the settlement of
the load.

The influence of ground abowve a vertical load, when calculating settlements in ground that is
abowe the load, is considered if the "Elastic analysis above loads" check-box is checked in
the Analysis Options dialog. If that option is unchecked then Pdisp will assume that all points
abowe the load settle by the same amount as those at the level of the load.

Horizontal displacements resulting from vertical loads on horizontal planes are not calculated.

If the Mindlin method is chosen without the Legacy Mindlin option, then the most recently
implemented Mindlin method of Pdisp versions 19.0 and later will be invoked. This has the following
characteristics that supplement those of the Legacy Mindlin method.

Both vertical and horizontal displacements are calculated resulting from normal and tangential

loads on vertical and horizontal planes.

Consideration is given to the influence of ground abowve a load acting on horizontal plane when

calculating settlements at points below the load, so soil above the load contributes to resisting
the settlement of the load. Howevwer, this can be changed by the user.

Displacements "behind" horizontal loads are calculated assuming elastic soil behind the load.

Table 1
Summary of Mindlin Methods
Legacy New Mindlin New Mindlin
Mindlin without
correction factor
(in Pdisp 19.0)

Soil above load considered to X v v
dampen displacements below it
Original correction factor for v X v
heave in soft soils above the
load
New correction factor for heave X X v
in soft soils above the load
Vertical (normal) loads on v v v
horizontal planes
Vertical (tangential) loads on X v v
vertical planes
Horizontal (normal) loads on X v v
vertical planes
Horizontal (tangential) loads on X v v
horizontal planes

© Oasys Ltd. 2019



Methods of Analysis 9

2.3.2

Settlement above the Load

Pdisp allows computation of settlement by several different methods. In particular, for the Mindlin
methods, alternative assumptions can be made about the effect of the ground above a subsurface
load.

These methods are believed to be reasonably good for computation of elastic settlements beneath a
load, provided that the stiffness of the ground is wither constant or generally increasing with depth.

NOTE: These methods are not technically “correct”, but are proposed to find a formulation that gives

reasonable results.

Settlement above the load

In Figure 1 the blue solid cune represents settlements computed for a subsurface load in a uniform
material. Settlements abowve the load are derived in Pdisp in one of 2 ways:

A)Assume the settlement is the same as at the lewvel of the load — line AB in Figure 1.
B) Assume the Mindlin distribution above the level of the load — line AC in Figure 1.

If the load is deep in the ground, method A may seriously owverestimate the settlements at higher
levels abowve the load. Method B might be reasonably OK in uniform material.

The red curve in Figure 1 represents a situation in which the soil below the load is about 5 times
stiffer than it was for the blue line, but the soil above the load is unchanged. For this situation, a
“correct” solution for settlement above the load would probably look something like curve AD'. At
present GSPR uses method B abowve in Pdisp, so adopts curve A'C'. It can be seen that this can
give the unreasonable result that points above the load actually heave.

The problem is that A'C' relates to the settlement that would occur at level A if the material below A
were the same as that abowve (ie point A). This curve needs to be corrected to relate to the
settlement actually computed at level A (ie point A’).

© Oasys Ltd. 2019
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Settlement

Soil 1

Vertical load

Soil 2

Soil 3 etc

Rigid base

To correct the settlements above the load, either of the following two correction factors are applied:

Load

Displacement Levels

Notation: w(Zi) —vertical displacement at lewel Z,
M(Zi) — Mindlin integral at level Z

En—l
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Z,- level of first displacement point immediately above the load
M(Zn) — Reference Mindlin integral for use in equation (2) below. This is actually, the Mindlin integral

at level Z,
Legacy Correction Factor New Correction Factor
For Z, > Zn( > ZL),
W(Z) = W(Z, 1)*M(Z-)/M(Z- 1) With correction factor applied, the §ett|ement
I I- I I- is calculated up to the level of load in the
(1) same way as the Legacy Mindlin method,
_ . . _ BUT here the Mindlin integrals take into
For location Z,, (displacement level immediately account the soil abowe the load.
abowve load),
W(Z,) = WZ "M(Z)IM(Z,) = w(Z)) ForZ > 7 (> Z)),
W(Z) = W(Z 1) + [{(MZ)-MEZ_YETWZ)
For the other points abowe the load, )- :
WZ, 1) = w(zIO PMZ.. )IM(Z) = WZ M(Zen 1) M) MgV
n+1 n n+1 n L n+1
M(Z,) where E; is the Young's modulus in the sub-

. . layer immediately below Z.
W(Z110) = W(Z14.1)*M(Z, 1 0)IM(Z, 1. 1) = W(Z) )*M(Z,,

+2)/M(Zn) For location Zy

= _ / *
Thus, it can be seen that, equation (1) simplifies W(Z) = wW(Z)) + {M(Z))-MZ) VEI*'W(Z))
o {M(Z,)-M(Zgg VE, ]
W(Z) = W(Z *M(Z)IM(Z,,) , where Z, > Z,

—(2) Note: For points away from the load, the
correction factor i.e.

It should be noted that the Reference Mindlin

integral is evaluated at the location of the MZ)MZgg YEW(Z))
displacement level immediately above the load(i.e.
Z,), but NOT at the load(i.e. Z, ). As a result, is evaluated by considering the load to act at

W(Zn) is NOT the actual displacement at the level | ihe same plan location of the point under

Z_, but the displacement at the load level, Z. ) )
n consideration.

Thus, the heawe in the zone between the lewvels Zn
and ZL is not taken into account. Also, these

Mindlin integrals take into account the soil abowve
the load, unlike those used in the evaluation of
settlements up to the lewel of the load.

2.3.3 Settlement below the Load

The following discussion applies to only the new Mindlin method.

The settlement below the lewvel of the load is also affected by the presence of soil above the load. In
Pdisp, this effect may be
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234

2.34.1

(1) included as if the soil above were of the same stiffness as that below or
(2) disregarded (i.e. the computation is as though the load were at a soil surface).

This is applicable only for loads acting on horizontal planes. The user may choose either of these
options in Pdisp.

In GSPR, option (1) is currently used for horizontal loads on horizontal planes, and option (2) is used
for vertical loads on horizontal planes. These cannot be changed by the user.

These are also the default options for the new Mindlin method, when the user creates a new file in
the current version of Pdisp.

Note: When files created by version Pdisp 19.0 are read by this current version of Pdisp, option (1) is
used for vertical loads on horizontal planes.

Calculation Details

The Mindlin method does not calculate stresses, but implicitly assumes that the stresses in a given
layer are the same as they would be if the whole of the ground had the same elastic properties as
that layer.

The solution is therefore exact for a soil of constant elastic properties irrespective of layer thickness.

If the value of Young's modulus or Poisson's ratio varies with depth, then the materials should be
divided into sub-layers.

Displacements are calculated at the strata boundaries and at intermediate displacement levels when
these are specified, see Displacement Levels.

Mindlin (1936) derived equations for the displacement due to a vertical or horizontal point load applied
within a semi-infinite homogeneous, isotropic elastic half space. Vaziri et al (1982) provided
integrated forms of these equations to give horizontal and vertical displacements due to uniform
stresses applied to horizontal or vertical rectangular areas.

Vertical Displacements
The basic equation can be expressed as:

i
b,=—
* E
where:
M = Function of the relative distance between the load and the displacement point and Poisson's
ratio.
E = Young's modulus of the half space.

To analyse the sub-layer, the function M is first calculated at the top (M,)) and base (M,)) of the layer.
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2.3.4.2

For a layer with constant E, the relative settlement across the layer is:

5= [MtiE_Mbi:'
ti

Where E is assumed to vary linearly with depth, the approximation that M also varies linearly is
made:

S IR
? o (Bwi—Es) LBy

where:

E, = Young's modulus at top of layer

E, = Young's modulus at base of layer
z = Lewel

Horizontal Displacements

There are three options available to calculate the stiffness of soil for calculating horizontal
displacements

¢ use weighted average
® use greatest stiffness
¢ use stiffness at displacement point
Displacements "behind" horizontal loads are calculated assuming elastic soil behind the load.

Use Weighted Average

In this method, the average stiffness is calculated between the centroid of load and the displacement
point at which the horizontal displacement is required.

A line connecting the load and the displacement point is considered for the calculation of horizontal
displacements. This line can pass through different layers of different soil profiles associated with
different zones. Each layer has its own Young's modulus and Poisson's ratio. The average Young's
modulus and shear modulus are calculated by considering a weighting based on the length of the
line passing though each of the layers. The Poisson’s ratio to be used is then derived from the ratio
of average Young’'s modulus to average shear modulus.

Let the required Young's modulus and Poison's ratio be E* and v*.

The “average” E = E* = Z{E/L} / XL,
The “average” G = G* = L{G L}/ =L,

and G* = E¥/(2(1+v*). So v* = E*/ (2G*) - 1.

Where E varies with depth within a stratum, the average within the stratum is calculated by
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integration.
Use Greatest Stiffness

In this method, Pdisp takes the maximum Young’s modulus that occurs along the line connecting
the load and the displacement point. The Poisson's ratio is set to that of the stratum where the
greatest E is found.

Use Stiffness at Displacement Point
This method should be used with caution.

In this method the stiffness at the displacement point is used for calculating horizontal
displacements. The soil properties between the load and the displacement points are disregarded.

The horizontal displacements are calculated through soil zones. The properties of soil material for
calculating horizontal displacements are taken by it Z co-ordinate. If a point lies in a soil strata with
different top and bottom Young's modulus, the value at the point is linearly interpolated.
Intermediate points within the zone for calculating the horizontal displacement are taken in the
direction of the load.

Zone 1 2 3 4

//1
X &

Displacement| point

Flan wiew

2.3.5 Accuracy of the Mindlin Solution

The Mindlin solution is exact if the elastic properties are constant with depth. The solution for an
individual layer with constant elastic properties is also exact. The solution for vertical loading is a
good approximation provided stiffness does not decrease significantly with depth. For horizontal
loading the accuracy of each of the methods offered by the program is problem-dependent and
should be considered by the user.

Sub-layers are therefore only required if the value of stiffness varies within a layer.

© Oasys Ltd. 2019



Methods of Analysis 15

The default ratio for the maximum variation of Young's modulus within the sub-layer is 1.5. This
provides sufficient accuracy for most purposes.

24 1D Compression

Pdisp assumes the Boussinesq stress distributions.

For the purpose of this note uniform pressure loading of a circular area is considered, concentrating
on a point at the ground surface and at the centre of the load. Also, Poulos and Davies Eq 3.13a and
3.13b are used.

In 1D compression, the ratio of the horizontal to vertical stress change is v/(1-v). In Boussinesq it is
(1+2v)/2, which is larger than in the 1D case. The reason for this larger horizontal stress increase is
that the load is not transferred vertically, but spreads into the ground:

Load
SE A

/';T'R

The process of spreading implies a horizontal component of stress which converges on the loaded
area, increasing the horizontal stress by more than v/(1-v). The larger increase of horizontal stress
leads to a smaller vertical strain. The ratio of vertical strains (1D — Boussinesq) / 1D is equal to v.

The Boussinesq stress distribution is strictly only correct for loading on the surface of a
homogeneous isotropic infinite half-space. It may be thought that by loading a very large area, 1D
compression would apply at the ground surface and at the centre of the load. But no matter how
large the loaded area, it is small compared with the “infinite” half space of the theory, so the effect on
horizontal stress still applies.

In reality, the stress distribution is changed by the non-homogeneity of the ground, a generally
increasing stiffness with depth. This has proportionately more effect on horizontal than on ertical
stress, although the horizontal stresses have proportionately less effect on vertical strain and
settlement.

The fundamental assumption and approximation of Pdisp is that it uses the Boussinesq stress
distribution irrespective of non-homogeneity, and even of the rigid boundary at the base. (In this
respect, the Mindlin approach is no different.) This approximation is reasonably good in most cases,
but its inaccuracy may vary from case to case.
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The graph below shows the settlement computed for a 4.1m thick layer with Young’'s modulus
2500kPa, located beneath the centre of a large area loaded to 100kPa. The computed settlements
are shown for various values of Poisson'’s ratio.
180
Y —
- 140 \ \
E 120 \ \
—— i
_ 100 1D compression
E 80 —— Poulos and Davis - Loading
E \ \.\ on a circular area
P 60
-
2 \
a0 \
20
0 T T T T \
0 0.1 0.2 0.3 04 0.5 0.6
POISSON'S RATIO
Users should be aware of this feature so that they can decide whether the error involved is of
concern. Finite element analysis by programs such as Oasys Safe may provide a better general
solution in cases where inaccuracy is high. Analytical solutions for special cases might be found,
for example in Poulos & Davis.
2.5 Consolidation
Pdisp performs 1D consolidation calculations using the numerical approach. The Crank-Nicholson
finite difference method, which is implicit in time, is used to calculate the pore pressures.
251 PorePressures

The differential equation of consolidation is given by

Bu c #u
gt~ Y@zl
where,

C, - is the coefficient of consolidation
u -is the excess pore water pressure
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t -is thetime
z -is the depth

The finite difference approach used to solve this equation is based on a depth-time grid, where the y-
axis represents the depth and the x-axis represents the time step. Each point on the grid is a
representative of the excess pore water pressure at a particular depth and at a particular time step.

j (time step)
»
t=0 Pl |
EEEE—
Favd
i (depth)
Ui Ujq j+1
Y
Ll i L ij+1
Uisq, Uiz j+1
where,

- is the excess pore water pressure at i'" depth position and ji" time step

Crank-Nicholson Method

In this method, the differential equation for consolidation is solved by substituting the forward
difference at time 't' for du/ét and the second central difference for 8%u/6z>. However, the second

central difference is taken as the average value of the central differences at the (i,j)" and (i, j+1)™
levels.

After re-arranging the terms in the resulting equation, the generic equation for the Crank-Nicholson
method at any grid point is given by

2(1+7) 2(1 —r)
TUpggr t T Wigen T Uipaen T Wy b Uy Ui

where,
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C, At
r = .
Az

where,
Az - is the distance between it" and (i+1)™" level
At - is the time step

Note: It is recommended that the condition 1/3 < r < 2 is satisfied (Abid and Pyrah) for each stratum
of a profile either by altering the number of intermediate displacement lewvels of a stratum or the time

step. Otherwise it may lead to discretisation errors and numerical disturbances.

The above equation is applied at all grid points to get a system of linear equations, which takes the
form

[Allu] = [C]

where,
A - is the coefficient matrix, which is tridiagonal in nature
u - is the excess pore pressure matrix

C - is the constant matrix

In the equation abowe, the coefficient and constant matrices are known, so the ‘'u' matrix is calculated
as

[ul = [A]*[C]

This procedure is repeated at every time step to get the values of 'u' at all grid points.

2.5.1.1 Boundary Conditions

1) The phreatic surface in an undrained material is assumed to be freely draining and hence the
excess pore pressure there is assumed to be zero.
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] itime step)
j=0 Mt u=0
I:D A N N NN NN ENENEEESESES G @E @RS ;DN LN B B B B BN B )
i (depth)
¥
A
Drained
v u=a
4 At
b E—
Undrained

FaY

Favd

2) The initial excess pore pressure at a point for time step t = 0 is equal to the vertical effective
stress at the point obtained through elastic calculations.

Auo = on
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t=0 At
— >

Fayd

3) If the Rigid Boundary Level is permeable, then the pore pressure values for it are assumed to be
zero.

=0 At
=0

AT

u=10 RBL

4) If the Rigid Boundary Level is impermeable, then imaginary nodes are assumed on the other side
of the boundary, which are reflections of the immediate nodes on the top of the boundary.

Thus, u, =u, andu, ., = U, .. These values are substituted in the generic equation for the
boundary.
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j=0 Mt
«—»
i=0
Fa¥d
Ui, Ui j+1
RBL
Imaginary
Level
Ujs1j Ui, jo1
25.2 Layered System
j (time step)
>
t=0 Mt
EEEE—
i (depth) Layer A
Uiz4|
FAV.Y
Interface
L;
A Zg
Layer B
Ui

For a layered system, the pore pressure for an interface node is obtained by applying the continuity
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equation for flow across the interface. The final equation is shown below.
— U jer T AUy jeq = Py jur = Wimqj + AUy + By

where,

1
A = E(*’Pu + fLs)

1
Ay = 3 (@ra + Begrs)

where,

2(1 4+ 1y)
Pra =T
2(1+1g)
Pre =1‘"—3
Pra =T
Pre =T
a= ﬁzj
B = ﬁzﬁ.
B = kpAza
kA ."_"LEB

The user can input either k or C, for a layer. Based on the value input and the consolidation method
selected. The following relations are used to get C, from k or vice versa.

m, method:

k=my,ywl
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C. method:

_ Co= Qua3dsyy=Cp
(1+e,)sc"

k

Where,

Y,, - is the unit weight of water

o' - is the effective stress

C. - is the compression index of the soil

2.5.3 Degree of Consolidation

Degree of Consolidation

The pore pressures that are obtained are used to calculate the degree of consolidation (U) for each

time step.
- [udz
B [ dz
where,

u, - is the initial excess pore pressure
u - is the excess pore pressure at the time step under consolidation

254 Settlement
Two components of consolidation are calculated.

e Primary
e Secondary

2.5.4.1 Primary Consolidation
Two methods are used for the calculation of primary consolidation

1) m, method
2) C, method
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2.5.4.1.1 mv method

This is a linear approach.
The primary consolidation at any node in an undrained layer is given by:

primary consolidation = mv*Ac‘V_avg*H
where,
m, - is the coefficient of compressibility of the layer

H - is the distance between the it" and (i+1)!" levels
Ao‘v_avg - is the average of vertical effective stress at the it" and (i+1)" levels

Example

Let 't' be the time step at which settlement is to be calculated at node '3' shown in the image below

Layer A 1@ Drained Water

~7 Table

Layer B 3
v b Undrained

Layer C 59
Drained

Layer D i Undrained

The primary consolidation at node 3 at a time step 't' is given by the sum of following

1. Primary Consolidation of 7-8
2. Primary Consolidation of 6-7
3. Primary Consolidation of 3-4

If the element is in a layer that is undrained and submerged, then primary consolidation at time step
' is given by
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settlement = U, * (mV*AG'v.avg*H)

where,

U, - is the degree of consolidation at that time step of that undrained submerged layer
m, - is the coefficient of compressibility of the layer
H - is the distance between the i" and (i+1)" levels

Ao'v_avg - is the average of vertical effective stress at the i" and (i+1)™" levels

Applying this to the example under consideration,

¢ Primary Consolidation of 7-8 = Ut-layerD * (mv_layerD*Ao‘v»avgm*H)
* Primary Consolidation of 6-7 = U, ayerd (mv_Iay o AT, 96_7*H)
¢ Primary Consolidation of 3-4 = U jayers * (mv-layerB*Aclv-avg3- ~H)

Hence, total primary consolidation at 3 at a time step 't'

Ao’

* *
Ao t-lay erB (mv—layerB V-

H) + U H) + U

— * * ' * * * ' *
- Ut—layerD (mv—layerD v-avg7-8 t-lay erD (mv—layerD on—avgﬁ—?

H)

*
avg3-4
Total settlement at 3 at a time step 't' is given by

Total Settlement = Immediate settlement at '3' calculated using the elastic method (Mindlin/
Boussinesq) selected for the model + Total primary consolidation at '3' (explained abowe)

2.5.4.1.2 Cc method
This is a non-linear approach.

The relationship between vertical strain and woid ratio is given as:

AH  Ae
Hﬁ_ 1+€D

where AH is the change in height of the layer and is the primary settlement s_. Hence the primary

consolidation is given as:

Ae
I}1+€|}

S, =

where,

AH - is the change in height of the layer
H, - is the original thickness of soil layer

Ae - is the change in the woid ratio between time 't' and initial condition
€, - Is the Initial or in situ void ratio
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Overconsolidated Soils

If the vertical effective stress at an instance is less than the preconsolidated stress (¢

is said to be overconsolidated.

Case 2 @

O e

Consider the wid ratio vs vertical effective stress plot above. Two cases arise:-

Case 1:

p), then the soil

If the vertical effective stress after the application of load is less than the preconsolidated stress, then

the change in woid ratio is given by:

o'y + Agy,
Ae = Clog————
o'y

Case 2:

If the vertical effective stress after the application of load is greater than the preconsolidated stress

then the change in woid ratio is given by:
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¥

& g’ + Ao,
Ae = C,lugf—?+fclug¥
g vy

r
T p

where,

C. - is the compression index of the soil

C, - is the recompression index of the soil

o'p - is the preconsolidation stress or maximum past vertical effective stress
a',, - is the vertical (effective) overburden stress

Ao, - is the applied stress

Normally Consolidated Soils:
The change in woid ratio for normally consolidated soils is given by:

o'y + Agy,
Ae = C; log————
a'vy

In PDisp, normally consolidated soils can be modelled by entering Pre-consolidation margin as 0 or

OCR as 1.

As for m, method primary consolidation is calculated only for layers that are undrained and

submerged.

Total settlement (at time step t) = Immediate settlement calculated using the elastic method
(Mindlin/Boussinesq) selected for the model + Total primary consolidation (at time step t)

2.5.4.2 Secondary Compression

PDisp assumes that secondary compression happens after 95% of consolidation. Hence, it is
calculated for time steps at which the degree of consolidation is more than 95%. i.e. t > t, -

Secondary compression is calculated as

C o1 t
T+e ° %,

5=

where,

C, - is the secondary compression index of the soil
€, - is the initial or in situ void ratio

H, - is the original thickness of soil layer

tp - is the time taken to achieve 95% consolidation.
t - is the time at the current time step.
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If the m, method is chosen, then input of C__ is required instead of C_and e,,.
C
Coa = =
1+ =0
The secondary settlement is then calculated as:
t
5.= Co.Hplog—
tp
where,
C,e - Is the modified secondary compression index of the soil
When the degree of primary consolidation reaches 95%, secondary compression is calculated and
added to the total settlement.
3 Input Data
3.1 General

3.2

The following provides details of all the information required to run the Pdisp program.
On selection of the Pdisp program the main screen will open.

The "Welcome to Pdisp screen” will pop up next, if it is enabled by the user in the Preferences
dialog. This allows the user to either create a new data file, to open an existing file, or to select a file
from a list of recently used files.

If the startup dialog on the program menu is disabled, the user can create a new project file via:

¢ File | New menu button or
¢ the new file icon in the Standard Toolbar.

This will open a new "Titles" window and allows the user to proceed.

The About button allows the user to view the program details, whereas the Home Page button
opens the Pdisp home page in a browser.

Preferences

This dialog can be accessed by clicking Tools | Preferences. Preferences can be set whether a file is
opened or not.

The Preferences dialog is accessible by choosing Tools | Preferences from the program's menu. It
allows user to modify settings such as numeric format for output, show welcome screen, option for
new model wizard, print parameters and company information. These choices are stored in the
computer's registry and are therefore associated with the program rather than the data file. All data
files will adopt the same choices.
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3.3

Numeric Format controls the output of numerical data in the Text Output. The Text Output presents
input data and results in a variety of numeric formats, the format being selected to suit the data.
Engineering, Decimal, and Scientific formats are supported. The numbers of significant figures or
decimal places, and the smallest value distinguished from zero, may be set by the user.

Restore Defaults resets the Numeric Format specifications to program defaults.

A time interval may be set to sawve data files automatically. Automatic saving can be disabled if
required by clearing the "Save file.." check box.

Show Welcome Screen enables or disables the display of the Welcome Screen. The Welcome
Screen will appear on program start-up, and give the option for the user to create a new file, to open
an existing file by browsing, or to open a recently used file.

Company Info allows the user to change the company name and logo on the top of each page of
print out. To add a bitmap enter the full path of the file. The bitmap will appear fitted into a space
approximately 4cm by 1cm. The aspect ratio will be maintained. For internal Arup versions of the
program the bitmap option is not available.

Page Setup Opens the Page Setup dialog allowing the style of output for printed text and graphics
to be selected.

If 'Calculation Sheet Layout™ is selected the page is formatted as a calculation sheet with details
inserted in the page header.

If "Logo” is selected the company logo is inserted in the top left corner of the page.

If "‘Border” is selected this gives a border but no header information.

If "Clipped” is selected the output is clipped leaving a space for the logo. This has no effect on text
output.

Data Input

All data is input via options on the program's Data menu, or via the Gateway.

The information can be entered in any order. The exception is that Soil Profiles must be entered
before Soil Zones. Once the data has been entered the program places a tick against that item in
the menu list.

Graphical Input allows the areas for rectangular or circular load data, soil zones and displacement
data to be drawn rather than entered as tabular input.

The Graphic Settings option displays a dialog that controls the format and content of 3D Graphics
View.

Pile-soil interaction related information can be entered only if the "GSA raft analysis data" option is
selected in the Analysis Options.
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3.3.1 Titles

The first window to appear, for entry of data into Pdisp, is the Titles window.

This window allows entry of identification data for each program file. The following fields are available:

Job Number allows entry of an identifying job number

Initials for entry of the user's initials

Date this field is set by the program at the date the file is saved
Job Title allows a single line for entry of the job title

Subtitle allows a single line of additional job or calculation information

Calculation Heading allows a single line for the main calculation heading

The titles are reproduced in the title block at the head of all printed information for the calculations.
The fields should therefore be used to provide as many details as possible to identify the individual
calculation runs.

An additional field for notes has also been included to allow the entry of a detailed description of the

calculation. This can be reproduced at the start of the data output by selection of notes using File |
Print Selection.

3.3.1.1 Titles window - Bitmaps

The box to the left of the Titles window can be used to display a picture beside the file titles.

To add a picture place an image on to the clipboard. This must be in a RGB (Red / Green / Blue)

Bitmap format. Select the button to place the image in the box.

The image is purely for use as a prompt on the screen and can not be copied into the output data.
Care should be taken not to copy large bitmaps, which can dramatically increase the size of the file.

To remowe a bitmap select the button.

3.3.2 Units

The Units dialog is accessible via the Gateway, or by choosing Data | Units from the program's
menu. It allows the user to specify the units for entering the data and reporting the results of the
calculations. These choices are stored in, and therefore associated with, the data file.

Default options are the Systéme Internationale (Sl) units - KN and m. The drop down menus provide
alternative units with their respective conversion factors to metric.

Standard sets of units may be set by selecting any of the buttons: SI, KN-m, Kip-ft Kip-in.

Once the correct units have been selected then click 'OK' to continue.
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Sl units have been used as the default standard throughout this document.

3.3.3 Analysis Options

The following data is entered to define the outline of the problem and the type of analysis to be
carried out.

e General tab - for general model parameters that are relevant to both elastic and consolidation
calculations

e Elastic tab - for general model parameters that are relevant to only elastic calculations

e Consolidation tab - for general model parameters that are relevant to only consolidation
calculations

3.3.3.1 General

Global Poisson's Ratio for calculation of stresses (Boussinesq solution only)
See also Global Poisson's ratio.

Maximum Allowable Ratio (Ra) between values of Young's modulus (E) at adjacent
displacement levels. The default value is 1.5.

See also Young's modulus (E).
An equivalent rigid boundary level i.e. the solution boundary or base of the lowest soil layer.

GSA raft analysis data enables the input of pile-soil interaction properties and pile-soil
interaction coefficients. The pile-soil interaction data is not used in Pdisp's analyses and so
does not affect its results. These data are included for export to Oasys GSA in order for GSA to
perform raft analysis.

Displacements at load centroids reports the displacements and stress/strain results at the
centre of the specified loaded areas. This is in addition to the locations specified by
Displacement Data.

3.3.3.2 Elastic

Elastic enables the elastic calculations

e Analysis Method

Boussinesq

This method calculates vertical displacements only. It is applicable for settlements and
stresses resulting from vertical loads on horizontal planes. If other loads are specified, these
will be ignored by the analysis. For further details see the Boussinesq Analysis Method.

Mindlin

The Legacy method represents the Mindlin method of Vdisp versions 18.2 and earlier. |If
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the Legacy Mindlin checkbox is unchecked, then the most recently implemented Mindlin
method, of Pdisp versions 19.0 and later, will be invoked. See Mindlin and the Legacy
Mindlin Method for a comparison of these methods.

Elastic analysis above loads reduces, with height, the settlement abowve loads which are
applied below ground level. It may only be switched off in the Legacy Mindlin solution, see
Mindlin and the Legacy Mindlin Method.

If horizontal displacements are not required, then Calculate horizontal displacements
should be un-checked. This will speed up the calculations. This option is not applicable for
the Legacy Mindlin and Boussinesq methods since they do not predict horizontal
displacements.

e Stiffness for horizontal displacement calculations
Use weighted average

In this method, the average Young’s modulus and Poisson's ratio are calculated between the
centroid of each load and the displacement point at which the horizontal displacement is
required. For further details see Horizontal displacements.

Use greatest stiffness

In this method, the maximum Young’'s modulus that occurs between the centroid of each
load and the displacement point is used for the calculations. The Poisson’s ratio is set to
that of the stratum where the greatest E is found. For further details see Horizontal
displacements.

Use stiffness at displacement point

In this method, the stiffness at the displacement point is used for calculating horizontal
displacements. The soil properties between the load and the displacement points are
disregarded. This method should be used with caution. For further details see the Horizontal
displacements.

e Heave correction factor

When calculating the displacements above the load, especially when there are softer soils
over stiffer soils, correction factors are applied to the calculations to prevent excessive
displacements in the softer soil layers.There are two options to choose from - the older
version of correction factor that was used in the legacy Mindlin solution, or the new
correction factor which is believed to be more accurate. By default, the newer option is used.
Howe\er, if the user decides to use the Legacy correction factor, he should select the
corresponding check box. See also Settlement above the load.

e Effect of soil above load

When calculating the displacements below the load acting on horizontal plane, the user has
the option to ignore the effect of soil above the load in calculations - both for normal and
tangential loads. See also Mindlin and Legacy Mindlin methods and Settlement below the
load.r topic text here.
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3.3.3.3 Consolidation

e Consolidation enables the consolidation calculations
e Time Period over which the consolidation calculations are to be performed.

e Time Step i.e. the interval at which the consolidation calculations are to be performed and their
results reported.

* Impermeable Rigid Boundary - the boundary condition for the calculation of excess pore
water pressure.

* k/C, input permeability or coefficient of consolidation

The ground water profile is hydrostatic.
¢ Level of the water table
e Pressure at the phreatic surface

e Unit weight of water

3.3.4 Soil Profiles

The soil profiles window allows the ground conditions to be entered. These are modelled as a
series of ground profiles. The profiles are entered in tabular form.

Soil profiles are vertical columns through the ground which are separated into lewvels of strata. A new
table is created for each soil profile. Each new profile is created by selecting the next tab along the
top of the table.

Layers must be entered in order of decreasing level.
The lateral extent of each soil profile is specified later as a soil zone.
Each sail profile requires the following data to be entered:

* name of stratum

* |evel at top of each stratum

* number of intermediate displacement levels
® Young's modulus

® Poisson's ratio

If the consolidation option has been selected, then the following additional data items need to be
entered:

* Method : m /C_/None
If m, is selected
= m, - coefficient of volume compressibility
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3.34.1

3.3.4.2

= C, - modified secondary compression index

If Cc is selected

" g, - initial void ratio

= C, - compression index

* C, - Recompression index

=  Owercons. Calc. Type:
o Pre-consolidation pressure
0 Ower-consolidation Ratio (OCR)
o Pre-consolidation margin

= C, - secondary compression index

If None is selected then the layer undergoes no consolidation

. CV - coefficient of consolidation.
e k- coefficient of permeability

Default values for the above can be set by clicking on the grey default boxes at the top of each
column and entering a value. These values are then adopted for new layers unless reset.

The Colour field indicates the colour of the stratum of the profile when displayed in the 3D Graphical
Output. The program will assign a default colour when creating a record if all other fields in the
record are valid. The colour can be changed by left-clicking the cell.

The column for identifying non-linear curves to individual layers of strata is only added to the table for
soil profiles once a non-linear curve has been defined. See section for Non-linear Materials.

The pile-soil interaction property column is only available if GSA raft analysis data has been
enabled in the Analysis Options. It allows the selection of a pile-soil interaction property to be
associated with each layer of a soil profile. The pile-soil interaction data is not used in PDisp's
analyses and so does not affect its results. These data are included for export to Oasys GSA in
order for GSA to perform raft analysis. For further details see Pile-soil interaction using GsRaft.

Displacement Levels

Displacement lewvels sub-divide each layer of soil into a number of sub-layers. For example the
specification of two intermediate displacement levels will divide the layer of soil into three sub-layers.

This process also defines the number of stress calculation points, with depth, for the Boussinesq
solution. The stresses are calculated at the centre of each sub-layer.

The lateral location of each calculation point is defined by the use of displacement grids, see
Displacement Data.

Number of Displacement Levels

The number of displacement lewels calculated is determined as the larger of:

¢ a user-specified number (N) given for each soil layer
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* an automatically generated number (n) taken from the Maximum Allowable Ratio (R,)
between values of Young's modulus (E), see Young's modulus (E).

Et= 20 MKim2

3 Intermediate Displacement
Levels

En = 70 MMim 2

\ﬁ Frofile of Young's Modulus

The value of n is calculated by
E
log —h]
= —[ Et
logR,
So, for the example illustrated abowe, if R =1.5
then
m{%
N=——>=30838=13
gl & =

The value of n is always taken as the next lowest integer.

The value of R_=1.5 is normally sufficiently accurate for most problems.

3.3.4.3 Location of Displacement Levels

If Young's modulus (E) is constant with depth then the displacement lewvels will be evenly spaced. If
E increases with depth then the sub-layers are bunched around the lowest values of E in the
following way:
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40 moD
i=o \ = 30moD
AZ
l 10 mOD
Frofile of Young's Modulus
0 moD
z, = lewel of top of strata layer
A, = thickness of strata layer
j = number of sub-layer (as shown abowe)
| = lewel of sub-layer
n = nor N (See Number of Displacement Lewels).
1 1
E, | 704
R=|=| egR=|—| =1518
[Et] or-(5]
where:
2 f—
e 1=30-20| 22X 1918 220 155 g5
20=1.9187 =20
For consolidation calculations, a displacement lewvel is added at the water level if it does not coincide
with the existing lewels.
3.3.44 Young's Modulus (E)

The Young's modulus for the soil can be entered as a constant value or varying linearly with depth.

Values are required for the top and base of each stratum layer.

For soils in which the Young's modulus (E) varies linearly with depth, additional sub-layers can be
generated automatically by specifying the Maximum Allowable Ratio (R,) of Young's modulus

between adjacent stress evaluation points. This ratio controls the maximum variation of E within

each sub-layer.
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3.35

3.3.5.1

The Maximum Allowable Ratio (R,) between values of E at adjacent displacement lewels is

m

_b = R
E, 2
where:
E, = Young's modulus at the top of the stratum
E, = Young's modulus at the base of the stratum

The minimum value of R_ is 1.0. The default value of R_is 1.5. This is normally sufficiently accurate
for most general models. See also Number of Displacement Lewels.

Load Data

The following types of loads can be input.

e Rectangular
e Circular
e Polygonal

Rectangular

If the Mindlin analysis method is chosen then rectangular loads may be applied applied vertically
and/or horizontally on horizontal and vertical planes (i.e. in both the normal and horizontal directions).

If the Boussinesq analysis method is chosen then loads may be applied only vertically on horizontal
planes (i.e. in the normal direction).

Loads can be superimposed and placed at any lewvel. All loads are completely flexible - no allowance
is made for stiffness of the structures.

Note : The loaded areas can be entered in tabular form (as described below). Horizontal planes with
vertical rectangular loads, without any rotation can be entered in graphical form. For information on
entry of graphical data see Graphical Input.

Specification of the load in the table view. Much is context sensitive so its accessibility depends on
the load shape and orientation of the loaded plane

Orientation can be either horizontal or vertical.
Centre of load is the centre-point of the load for defining its plane entered in global co-ordinates.

Angle of local x w.r.t. global X orientates the local axis. The plane can be rotated (in plan) by an
angle. The base point for the rotation is the centre of the load. The figures below illustrate the local
axis in relation to the global axis. Although the shape then remains the same, and normal loads are
unaffected, the directions of tangential loads will be affected. The angle of local x w.r.t. global X is
zero for loads parallel to the Cartesian co-ordinate system. Positive angles are counter-clockwise.
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Width and Depth of a rectangular load are measured in the local x and local y directions
respectively.

Load value specifies the load intensity to be applied to the plane. Depending on the analysis
methods, loads can be either normal or tangential to the loading plane. Tangential loads are specified
with respect to the local axis of the loaded plane (i.e. "tangential x" and "tangential y"). Normal loads
on horizontal planes are applied vertically downwards. The direction of normal loads on vertical
planes depends on the angle of rotation of the loaded plane as shown in figures below. Negative load
intensities can be specified to reverse their direction.

Harmal

Vertical load on horizontal plane rotated in counter-clockwise direction

T .
Rotation

Y Marrmal

Mormal

i

vy X

L J

Horizontal load on vertical plane rotated in counter-clockwise direction
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3.3.5.2

Circular

If the Mindlin analysis method is chosen then circular loads may be applied applied vertically and/or
horizontally on horizontal and vertical planes (i.e. in both the normal and horizontal directions).

If the Boussinesq analysis method is chosen then loads may be applied only vertically on horizontal
planes (i.e. in the normal direction).

Loads can be superimposed and placed at any level. All loads are completely flexible - no allowance
is made for stiffness of the structures.

Note : The loaded areas can be entered in tabular form (as described below). Horizontal planes with
vertical circular loads, without any rotation can be entered in graphical form. For information on entry
of graphical data see Graphical Input.

Specification of the load in the table view. Much is context sensitive so its accessibility depends on
the load shape and orientation of the loaded plane

Orientation can be either horizontal or vertical.
Centre of load is the centre-point of the load for defining its plane entered in global co-ordinates.

Angle of local x w.r.t. global X orientates the local axis. The plane can be rotated (in plan) by an
angle. The base point for the rotation is the centre of the load. The figures below illustrate the local
axis in relation to the global axis. Circular loads can also be rotated. Although the shape then
remains the same, and normal loads are unaffected, the directions of tangential loads will be
affected. The angle of local x w.r.t. global Xis zero for loads parallel to the Cartesian co-ordinate
system. Positive angles are counter-clockwise.

Radius is for circular loads only.
Number of rectangles It defines the number of rectangles that will be used to represent the circular

load for the purpose of calculation. An odd number must be specified. A larger number will improve
the accuracy of the results close to the edge of the loaded area.

Representation of circular load by rectangles
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Load value specifies the load intensity to be applied to the plane. Depending on the analysis
methods, loads can be either normal or tangential to the loading plane. Tangential loads are specified
with respect to the local axis of the loaded plane (i.e. "tangential x" and "tangential y"). Normal loads
on horizontal planes are applied vertically downwards. The direction of normal loads on vertical
planes depends on the angle of rotation of the loaded plane as shown in figures below. Negative load
intensities can be specified to reverse their direction.

Harmal

Vertical load on horizontal plane rotated in counter-clockwise direction

& .
Rotation

Y Marrmal

Mormal

i

vy X

L J

Horizontal load on vertical plane rotated in counter-clockwise direction
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3.3.5.3

Polygonal

For both the Mindlin and Boussineg methods polygonally shaped loads may be applied only
vertically on horizontal planes (i.e. in the normal direction).

If the Boussinesq analysis method is chosen then loads may be applied only vertically on horizontal
planes (i.e. in the normal direction).

Loads can be superimposed and placed at any level. All loads are completely flexible - no allowance
is made for stiffness of the structures.

Specification of the load in the table view. Much is context sensitive so its accessibility depends on
the load shape and orientation of the loaded plane

Orientation can be either horizontal or vertical.

Angle of local x w.r.t. global X orientates the local axis. The plane can be rotated (in plan) by an
angle. The base point for the rotation is the centre of the load. The figures below illustrate the local
axis in relation to the global axis. Although the shape then remains the same, and normal loads are
unaffected, the directions of tangential loads will be affected. The angle of local x w.r.t. global Xis
zero for loads parallel to the Cartesian co-ordinate system. Positive angles are counter-clockwise.

The Coordinates of a polygonal load specify the vertices of the polygon, in the global XY plane
since polygonal loads may only be applied to horizontal surfaces.

The Rectangle Tolerance of a polygonal load specifies the tolerance that will be used to fit
rectangles to the load's polygon. For analysis the polygon is represented by a series of rectangular
loads. The rectangles that will be generated can be viewed, and the effect of adjusting tolerance
investigated, via the Polygon Wizard that is accessed by clicking the more button.

If more rectangles are required to represent a polygonal load then this can be achieved by altering
the Rectangle Tolerance. An illustration of the arrangement of rectangles that are used to
represent a polygonal load is available in the Polygon Wizard that is accessed by clicking the more
button.

Load value specifies the load intensity to be applied to the plane. Depending on the load shape
and analysis methods, loads can be either normal or tangential to the loading plane. Tangential loads
are specified with respect to the local axis of the loaded plane (i.e. "tangential x" and "tangential y").
Normal loads on horizontal planes are applied vertically downwards. The direction of normal loads on
vertical planes depends on the angle of rotation of the loaded plane as shown in figures below.
Negative load intensities can be specified to reverse their direction.
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Harmal

Vertical load on horizontal plane rotated in counter-clockwise direction

& .
Rotation

Y Mormal

Marrmal
b

¢ X

L 3

Horizontal load on vertical plane rotated in counter-clockwise direction

3.3.6 Polygon Wizard

The Polygon Wizard is opened by clicking the "more" button in the Load Data table. It allows editing
of a polygonal load's coordinates and its rectangle tolerance, together with the display of the
rectangles that will be generated for representation by rectangular loads during analysis.

The X and Y values are specified in global coordinates and define the vertices of the polygon upon
which the vertical (normal) load is to be applied. A polygon with duplicate vertices will only be
accepted if the duplicates are its start and end points. If the end point does not match the start point
then a closing edge will be assumed.

A polygon with coordinates that define edges that cross each other will not be accepted.
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Coordinates may be pasted from a range in a spreadsheet by copying it from the spreadsheet to the
clipboard, then right-clicking in the top left cell of the coordinates to which that range is to be pasted,
and pressing <ctrl> + "Vv".

To delete coordinates click the row header number, and press <del>.

The Display check-box should be selected in order to display the polygon expanded to rectangles.
Rectangles will only be generated for valid polygons. The coordinates may not be edited while the
rectangles are displayed. The Display check-box must first be de-selected.

In order to generate rectangles from a polygon the polygon is first expanded into trapezoids. Each
trapezoid is then expanded into one or more rectangles. The rectangle Tolerance is defined as the
total "overlap" and "underlap” of rectangles within each trapezoid, as a proportion of the total area of
that trapezoid. It may be varied via the slider or via direct input to the edit box in order to vary the
accuracy of fit. A lower tolerance will increase the accuracy of the fit but with the consequence that
analysis will take longer since more calculations will be required. Due to the methodology used,
trapezoids with greater differences in length of their parallel edges will generate more rectangles than
those of lesser difference - even though those with lesser difference may hawe larger areas.

Rectangles are recalculated immediately that the Tolerance is changed. Therefore, if using the edit
box to type a value, ensure that that value is always a valid number. This can be done most easily
by highlighting the whole number to edit it, rather than by positioning the cursor precisely in the edit
box, which risks creating invalid numbers upon typing.

The procedure for generating rectangles considers every edge as a candidate at right angles to which
rectangles can be created. Whichever edge would produce the fewest rectangles is then selected.
Hence, as the tolerance is varied the alignment of rectangles may change as well as their number,
as first one edge and then another becomes optimal.

The minimum width of rectangle that will be produced is 50mm. Trapezoids whose parallel sides are
less than that distance apart will be ignored, and those whose parallel sides are wider will be filled
with rectangles of width to suit the rectangle tolerance, or 50mm, whichever is smaller. In this way
the creation of insignificantly narrow rectangles arising from rounding of coordinates by the user
(particularly for non-orthogonal edges) is awoided.

The definition of each rectangle that is generated can be viewed in the Text Output by selecting the
Polygonal Loads' Rectangles item in its wizard.

3.3.7 Soil Zones

The soil zones window allows the lateral limits, if any, of each soil profile to be specified. This is
defined in terms of rectangular areas specified by corner x and y co-ordinates. The soil zones are
therefore aligned with the Cartesian coordinate system.

Soil zone areas may overlap. If this occurs then the profile relating to the soil zone with highest
allocated number will be used in the calculation.

If no soil zone is specified then the first soil profile is assumed to be widespread. Similarly, if
displacements are to be calculated for locations that are wide of any soil zones then the first soll
profile will be used.

The soil zones can be entered in either this tabular form or graphical form. For information on entry
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3.3.8

3.3.9

of graphical data see Graphical Input.

Polylines

Polylines are used to define displacement polylines.

The following input data is required to define a polyline.

Data may be input in dialog form by double-clicking within a cell of the Polylines input table.

-

-

] sample.pdd : Polylines = ol ™
J— |
3 EY
Ref. Name Coordinates
[m]
Defaults |Polyline #
1 Paolyline 1 [-70, -20, 0] (20, 20, 0]
W
| < >

Name specifies the name of the polyline.

Coordinates specify the end points of the segments that make up the polyline.

Displacement Data

The points at which displacement results are required can be specified using grids, lines, polylines or
individual points. Results can also be given for the centre of each loaded area, see Analysis
Options.

The grids, lines, polylines or points can be entered in tabular form.

Any number of grids, lines, polylines or points can be entered.

The following types of displacement data can be input.

Points
Lines
Polylines
Grids
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3.3.9.1 Points

Points are specified by single x, y and z co-ordinates.
Name is the name of the point.

X is the x coordinate of the point.

Y is the y coordinate of the point.

Z(level) is the lewel of the point.

Calculate specifies whether displacement calculations are to be performed for the point.

Detailed Results specifies whether the detailed results are to reported for the point

3.3.9.2 Lines

Lines can be entered in any orientation by specifying the co-ordinates at both ends.
Name is the name of the line.
Start and End points of the line are specified by entering their X, Y and Z (level) coordinates.

Intervals specify the number of intervals on the line.

Calculate specifies whether displacement calculations are to be performed for the line.

Detailed Results specifies whether the detailed results are to reported for the line.

3.3.9.3 Polylines

Displacement Polylines specify a series of point locations on a 3D polyline, for which ground
movement results are required.

D PDisp1 : Displacement Polylines | — || [=] ||-E."h|

—

Ref Mame Paolyline Intervals Calculate | ™
[No.]

=

Defaults |Displacement Polyline # 10:iMNo

1
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3.3.94

Name is the name of the Displacement Polyline.

Polyline is the polyline that is to be associated with the displacement polyline.
Intervals is the number of intervals on the displacement polyline.

Calculate specifies whether displacement calculations are to be performed for the point.

Grids

Grids can be entered horizontally,vertically or at an vertical inclination by extruding a line. The
Direction of extrusion is specified as one of the Global axes (X, Y or Z). A Line for extrusion must be
entered by specifying its end coordinates. For example, if ‘Global X is the direction of extrusion
then the table allows the specification of a line in the YZ plane.

Extrusion Depth

Paint2

Extrusion Depth

Extrusion direction: Global X Extrusion direction: Glabal ¥ Extrusion direction: Global Z

The extrusion depth should not be zero. Negative extrusion depth extrudes in the opposite to the
global directions.

The number of intervals is specified across and along the extrusion as shown below.

iy
E.m\ﬁ‘on pet

Paint 2

Calculate specifies whether displacement calculations are to be performed for the grid.
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Detailed Results specifies whether the detailed results are to reported for the grid.

3.3.10 Imported Displacements

Displacements from other programs may be imported from CSV files via 'File | Import |
Displacements...' from the program menu.

The subsequent CSV Results Import dialog allows the choice of whether locations in the CSV file
that are duplicates of those already read are to be ignored. If the "Skip duplicate locations" option is
checked, then a tolerance may be specified which is used to determine whether two locations are
considered to be duplicates. The tolerance specifies the maximum distance within which locations
are deemed to be duplicates. If a point is found to be a duplicate of a location already read from the
CSV file, then it will be ignored, and only the first point and its results read into the model's data.

The purpose of Imported Displacements is to combine the displacements from other programs
together with those from Xdisp. The combined displacements may then be shown on the Text
Output, the Plan View or the 3D Graphical Output View.

The import file should include rows of data beginning with one of the following keywords. Each row of
data contains displacement results for a single coordinate.

e LOAD_RESULT

e PO NT_RESULT

e LPO NT_RESULT

e GPO NT_RESULT

e | NTERMEDI ATE_LOAD_RESULT

e | NTERMEDI ATE_PO NT_RESULT
e | NTERMEDI ATE_LPOI NT_RESULT
e | NTERMEDI ATE_GPOI NT_RESULT

Whichever of these keywords is used, the data will be imported and treated in the same way. The
range of keywords is to allow the import of CSV files that have been exported from Xdisp or Oasys
Pdisp, which may contain any of these keywords.

Displacements follow the sequence: Keyword,x Coordinate,y Coordinate,z Coordinate,x
Displacement,y Displacement,z Displacement.

Units for data in the file are specified by the keywords DI SP and LENGTH (displacement and length
units respectively) followed by the index of the unit. Length and displacement units' indices are: O -
metres; 1 - centimetres; 2 - millimetres; 3 - feet; 4 - inches.

Units information should appear in the file before the displacement results.

e.g.

Dl SP, 2

LENGTH, 0

LOAD_RESULT, 0. 5, 43.5, 0, -0.4967472, - 93. 72664, 47. 38838

I NTERMVEDI ATE_LOAD_RESULT, 0. 5, 43. 5, - 2. 587683439, 0, 0, 38. 77201
| NTERMEDI ATE_LOAD_RESULT, 0. 5, 43. 5, -4, 0, 0, 34. 85815
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GPO NT_RESULT, - 80, -90, 0, 32. 98127, 27. 33411, - 0. 5642965
I NTERMEDI ATE_GPO NT_RESULT, - 80, - 90, -4, 0, 0, - 0. 5535589
I NTERMEDI ATE_GPOI NT_RESULT, - 80, - 90, -6, 0, 0, -0. 5062072
LPO NT_RESULT, - 70, - 80, 0, 41. 05777, 32. 48021, - 6. 13E- 03

| NTERMEDI ATE_LPO NT_RESULT, - 70, - 80, -4, 0,0, 3. 54E-02

I NTERMEDI ATE_LPO NT_RESULT, - 70, - 80, - 6, 0, 0, 0. 1545731
PO NT_RESULT, 0, 0, 0, 0. 7738549, - 31. 88898, 30. 52104

I NTERMEDI ATE_POI NT_RESULT, 0, 0, -4, 0,0, 26. 76711

I NTERMEDI ATE_PO NT_RESULT, 0, O, -6, 0, 0, 23. 55008

If units are not specified in the file then a dialog will be shown at the beginning of the import process
for the user to specify the units of the data in the file.

These imported displacements may be viewed via 'Data | Imported Displacements...' from the
program menu or via the Gateway. Once imported they are non-editable. Imported displacements
can be deleted by right-clicking in the Imported Displacements Table View and selecting 'Delete All'
from the subsequent context menu.

In order that imported displacements may be combined sensibly with displacements that are
generated by Xdisp, the following rules apply.

1) All coordinates of data in the import file are imported whether a match is found for them or
not in the displacement grids, lines and points of the current Xdisp file.

2) The checking of whether coordinates match those of the displacement grids, lines and
points in the Xdisp file is performed at the time of analysis. The tolerance for coincidence is
1 mm in all of the x, y and z directions. Those coordinates which match any in the Xdisp file
will have their results added to those of that Xdisp file after analysis.

3) If there are multiple entries of displacements for the same point in the import file, all those
displacements will be added to those calculated by Xdisp for the displacement position,
whether that position is modelled by Xdisp as a displacement point, or as a point within a
displacement line or grid.

4) Similarly, if one point in the import file is matched with more than one in the data file, e.qg. if
displacement points, lines or grids contain coincident positions, then the imported
displacements will be added to each of the matching positions in the data file.

The diagram below illustrates a series of displacement coordinates in a CSV import file, a
Displacement Grid, a Displacement Line, and three Displacement Points in an Xdisp data file. It
shows how the results would be combined.
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(a}Imported Displacements (b) Displacemsnt Grid (c) DisplacementLing (d) Displacement Points
Key

Imported displacement data pointrepresenting a single row of the CSV importfile

Oy
L ) Displacementdata point specifiedin datafile whose results will notbe addedto any of the imported data points

- .:_.'. .g;j_'éj. Displacementdata point specifiedin datafile whose results will be addedto those of an imported data point

Coordinates such as 'A' are present in the CSV import file in one row of data only with one set of x, y
and z displacements. Coordinates such as 'B' are present in the CSV file in two rows of data and so
have two sets of x,y and z displacements. Coordinates such as 'C' are present only in the Xdisp
data file and not in the CSV import file. Their results will therefore only reflect the results from
Xdisp's calculation of displacements. Coordinates such as 'D' are present in the Xdisp data file, but
also in two rows of the CSV import file. Their results will therefore be the sum of those from Xdisp's
calculation of displacements and the two rows of results in the CSV import file. Coordinates such as
'E' are present in the Xdisp data file and in one row of the CSV import file. Their results will therefore
be the sum of those from Xdisp's calculation of displacements and that one row of results in the CSV
import file.

If an imported result is intended to be added to results at each displacement point in the Xdisp data
file, then care should be taken to ensure that the imported file contains one result for every data
point. When importing results from Oasys Pdisp this is most easily achieved by creating the same
set of Displacement Grids, Lines and Points in the two programs for export from one and import to
the other. Having created the Displacement Grids, Lines and Points in one of the programs they can
be input to the other by copying and pasting between the programs' Displacement Data table views
by highlighting the required cells and via the right-click context menu options of 'Copy' and 'Paste'.
Note that the last columns in the Displacement Data for the two programs may display different data,
so only the first, common columns should be copied.

Caution should be employed if results are inspected for which not all points of Displacement Grids,
Lines and Points have matching imported displacements.

The Text Output may be inspected for a summary of the displacements that have been imported and,
after analysis, those which have been found to match displacement points in the Xdisp file.
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3.3.11

3.3.12

DXF Import of Background Data

The Background Data table can be accessed via 'Data | Background Data' from the program menu or
via the Gateway. It displays the DXF entities (LINES, POLYLINES, LWPOLYLINES and CIRCLES),
that have been imported from a DXF file by selecting File->Import->AutoCAD (DXF file)... from the
program menu. This data may then be displayed on the 3D Graphical Output view as a backdrop to
the model data.

The data may be manipulated by right-clicking in the table, or, in the case of the wizard, by double-
clicking in a cell. The subsequent context menu presents the following options.

Wizard displays a wizard dialog showing the DXF entity in more readable form. The Specification
field of the Background Data table gives the condensed information of DXF entities. The wizard may
also be accessed by clicking on the wizard button present on the Pdisp Toolbar.

Delete deletes a row of the table, i.e. one DXF entity. First select a row by clicking its row header
number.

Delete All deletes all rows of the table, i.e. all the DXF entities. The Background Data table will then
be removed from the Gateway.

Translate shifts all DXF entities by specified x, y and z distances. In this way the origin of the DXF
data can be mowed to suit that of the Pdisp model.

Crop remowes all DXF entities that lie either wholly outside, or partially outside a specified "box" of x,
y and z range. If all DXF data has been imported with the same z lewvel, then the cropping volume will
remove all data if its minimum and maximum z values are not changed from their defaults of the sole
z level found in the data.

Cropping allows the easy removal of rogue DXF data (e.g. from title blocks of drawings) that has been
imported inadvertently with coordinates far distant from the Pdisp model data. Such data may
otherwise make invisible the display of model data in the 3D Graphical Output.

All Background data can also be deleted via the 3D Graphical Output's context menu (i.e. by right-
clicking on the 3D Graphical Output view and selecting "Delete Background Data" from the
subsequent context menu). Imported DXF background data in the 3D Graphical Output view can be
displayed or hidden via the Graphic Settings property sheet.

A sample DXF file is supplied with the program. See Sample Files for more information.

Non-linear Materials

The value of stiffness (Young's modulus E) with depth is specified in the Soil Profiles window. For
linear materials each specified value of E will remain constant, at the given depth, throughout the
calculation for stress, strain and thereby displacement.

For models of materials where the relationship between stress and strain is non-linear a non-linear
curve must also be specified. This can be defined by the specification of a curve of strain versus
stiffness factor.

The curwve is deweloped from the soil stress/strain relationship.
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otress Factor
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For increasing values of strain, the factor (F) by which Young's modulus is to be modified, is defined
by:
Sl
O

where oL is the equivalent stress for a linear curve at a given strain (¢) and o, is the stress for the
non-linear curve.

All stresses referred to in this manual are stress changes due to the application of loads. No
account is taken of stresses existing in the ground before loading.

Entering new data

To enter a new non-linear cune click on the Add Curve tab at the top of the grid. This highlights the
Graph title box and provides the number of the next cunve. If you then click the right button whilst still
on the tab the Page Edit Options screen will appear. This allows the name of the cune to be altered

in addition to copying and deleting curves.

Non-linear curves can then be specified either in the table provided or by using the mouse cursor on
a pre-defined grid and clicking the left button to identify the required points.

Strain can be entered on a linear or log scale. The scales on the x and y axes can also be changed
clicking on the Xmax and Y max arrow keys in the view's status bar.

Grid: *Xmax 100 <lt] ¥max 1.0024* ¢ Linear  Log

Editing data
Points entered on the grid can be refined by editing the values displayed on the table.

Once the required curves have been entered then the user must return to the soil profile data
window. The table now allows the appropriate curve to be allocated to the correct soil type.

© Oasys Ltd. 2019



52 PDisp Oasys Geo Suite for Windows
3.3.13 Pile-Soil Interaction Using GsRaft

Pile-soil interaction properties can be entered only if the "GSA raft analysis data" option is selected
in the Analysis Options. The Oasys GSA program, which depends on Pdisp application data for
GsRatft analyses, uses these Pile-soil interaction properties, which provide additional information for
each soail stratum. The Pile-soil interaction properties do not affect the analyses or results of Pdisp.
The facility can also be used to model interaction between soil and spread foundations.
The ground interacts with elements of the shaft of a pile in 3 dimensions (X, y, z) and in the vertical,
z, direction at the pile base. In each case, the shape of the force-displacement curve for the
interaction is represented by o/c,, = C(&/D) for vertical displacement and C(&B) for horizontal
displacement, where:

o = interaction stress (shear or normal as relevant)

Oyt = maximum value of the stress

C(0 = a coefficient defined by a user-defined function (see Pile-soil interaction curves
C(..)

) = displacement

D, B = geometry parameters defined as below.
The values of & represent the relative displacement between the pile and the elastic ground near it.
That is, dis the non-linear deformation of the soil local to the pile, which is usually behaving in a non-
linear manner.
For circular piles:

D = diameter

B =B =D

x y

For rectangular piles, Bx and By are the sides of the rectangle.

p =2B + ZBy

D = p/n
For H sections:

Bx = flange width

By = web height + 2 x flange thickness

p = complete perimeter (roughly 2 x web height + 4 x flange)

D = (2B, + 2By)/n

3.3.14 Pile-Soil Interaction Curves (PSICs) C(..)

The user is required to specify a number of shapes for the Pile-Soil Interaction Curves named PSIC1,
PSIC2 etc.

For each PSIC, the coefficient C(d) is related to normalised relative displacement d (=&/B or &D). C
values for d beyond the range of values specified will be taken as 1.0 on the positive side and -1.0 on
the negative side.
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3.3.15

3.3.16

The scales on the x and y axes can also be changed by clicking on the x max and y max arrow
keys in the view's status bar. There is no limit for x max but 1.0 is the limit for y max.

The curve can be made symmetric about the origin by selecting the Symmetric check box for the
view's status bar. An asymmetric curve can be converted to a symmetric curve by choosing either to
use positive values to replace the negative values or vice-versa.

Pile-Soil Interaction Coefficients for lateral directions X and Y, vertical direction Z, and base, may be
derived by the user from p-y (lateral load - displacement), t-z (axial load - displacement) and g-z (tip
load - displacement) curves (tables and formulae) examples of which are given in section: References
- Pile-Soil Interation Curves.

Allocation of PSICs to Soil Strata

In each soil stratum, a Pile-Soil Interaction Curve (PSIC) is required for each dimension of
displacement of the shaft and for the vertical displacement of the base. If there is no pile base in the
stratum, then the base data are ignored. The maximum stress in each mode of interaction is also
required.

Graphical Input

Graphical Input is accessed via the Data menu, the Gateway or the Pdisp Toolbar. The following data
can be entered in both tabular and graphical form. The methods are fully interchangeable.

Soil Zones
R+ Displacement Data
P Load Data

This section describes how to enter the data graphically.
Entering New Data

1. Select 'Data->Graphical Input' from the program's menu.
2. Select 'Graphics->Input’' from the program's menu or select the appropriate icon from the

Graphics Toolbar for soil zones , displacement data X 5 B or load data P . These
buttons are context dependent. When the Graphical Input View is active they both display and
allow input of soil zones, displacement data and load data respectively. Subsequently deactivating
a button does not hide the entity. Instead, when the Graphical Input View is active these entities
are hidden via 'Graphics -> Toggle items' from the program's menu. When the Plan View is active
these buttons allow display or hiding of soil zones, displacement data and load data respectively.

Once selected the cursor and left and right mouse buttons can then be used to enter the data.
Corresponding items can also be accessed via Graphics | Input from the program menu.
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3.3.16.1

3.3.16.2

3.3.16.3

Inserting Bitmaps

Bitmaps can be inserted behind the plan view. If the site plan is available, at a suitable scale in
bitmap form, then this can be placed behind the input data to check locations of loads etc. The
bitmap can be inserted in the following manner:

Select the bitmap button and open the required bitmap file.
This opens the Bitmap Scaling dialog.

Define the area required for the bitmap to cover in terms of maximum and minimum co-ordinates and
select "Load Bitmap".

The bitmap is then placed behind the main graphic in the Plan View.

Care should be taken not to copy large bitmaps, which can dramatically increase the size of the file.
If the bitmap was used during data input it may be better to remove and store it separately from the
Pdisp file.

Soil Zones - Graphical input

To enter the soil zones graphically; select the appropriate button for soil zones from the 2D
Graphics Toolbar. Or select: Graphics | Input | Soil zones from the program's menu.

1. Place the cursor (cross) over the start of the area required.
2. Hold down the left button and drag the mouse until the full area is defined.

Once the area has been defined the screen will prompt for the entry of additional data.
Enter the number of the appropriate soil zone and "Add to data".

This will also update the tabular input. If the zone's area requires additional editing then this should
be carried out using the tables.

Displacement Grids - Graphical input
To enter the displacement points, lines and grids graphically, select the appropriate button on the 2D

Graphics Toolbar X N8 or select: Graphics ->Input ->Displacements -> Points (Lines or
Grids) from the program's menu.

1. Use the cursor (cross) to place the corner of a grid or at the start of the a line or point
location.

2. Left-click to place a displacement point, or hold down the left button and drag the mouse until
the full displacement grid's area or displacement line's extent is defined .

Once defined the screen will prompt for the following additional information.

This will also update the Displacement Data table. If the grid requires additional editing then this
should be carried out using that table.

Once input of displacement points, lines or grids has been selected, the right mouse button may be
used to active a context menu from which the type of displacement entity for subsequent input may
be changed.
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3.3.16.4

4.1

v Poink
Line
Garid

Only horizontal lines and horizontal grids can be entered by Graphical Input. Others must be entered
in the Displacement Data table.

Load Data - Graphical input
To enter rectangular or cicrular load data graphically, select the load data button on the 2D Graphics
Toolbar i . Or Select: Graphics ->Input ->Loads from the program's menu.
1. Use the right mouse button to activate the context menu from which to select the type of data
entry.

v Rectangular
Circular

2. Use the cursor (cross) to place the corner of a rectangular area or centre of a circle.
3. Hold down the left button and drag the mouse until the full area is defined.

Once defined the screen will prompt for the following additional information.
The number of rectangles is only required for the circular loaded areas, see Load Data.

This will also update the Load Data table. If the area requires additional editing then this should be
carried out using that table.

Only normal (wertical) loads on horizontal planes, with no rotation in plan can be entered by Graphical
Input. Others must be entered in the Load Data table.
Programming Interface

Programming interface is provided by COM Automation in PDisp

COM Automation allows commands to be issued from a separate process \ia a set of VBA or C++
instructions. The separate process could be a separate program or, indeed, a VBA script in a
spreadsheet.

COM Automation

COM Automation allows other programs to access PDisp operations by creating an instance of
PDisp class "pdispauto_XX X Application”, where "XX_ X' is the major and minor version of PDisp,
e.g."pdispauto_20_0.Application", then calling the exported functions of that class.

The available COM functions are listed in COM Functions. Some use enums and structs.

Note that function names are case sensitive.
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411

When installing PDisp the installer should be run with Administrator rights to ensure the PDisp.tlb file
is registered in the host computer's registry, thus enabling its functions to be recognised e.g. by the
Microsoft VBA editor. If the functions are not recognised, then it may be necessary to set the
reference to the PDisp.tlb file manually in the editor. The PDisp.tlb file can be found in the program
installation folder whose default location is specified in Sample Files.

More:

COM Export Functions
COM VBA Example
COM C++ Example

COM Export Functions

The PDisp COM export functions are listed below:

The return code (short data type) for all these functions is zero on successful execution, and -1 on
failure.

All input data are in Sl units. All the results obtained through the below mentioned functions are in Sl
units.

short NewFile()
Open a new model.
short Open (string filename)
Open a *.pdd file.
filename — the name of the file to be opened, including path and extension.
short Save ()
Sawe the data to the default file (i.e. overwriting the file that was opened or last saved).
short SaveAs (string filename)
Sawe the data to*.pdd file.
filename — the name of the file to be saved, including path and extension.
short Close ()

Close the current file.

short CheckData()
Checks the data of the current file. (Recommended before analysis.)

short Analyse ()

Analyse the current file.
short Delete ()

Deletes the results in the current file.
short Show ()

Show the running instance of PDisp created by the Automation client.
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short AnalysisMethod (short* sMethod)

Gets the method of analysis.
0 - Mindlin
1 - Boussinesq

short SetAnalysisMethod (short sMethod)

Sets the method of analysis.
0 - Mindlin
1 - Boussinesq

short Elastic (VARIANT_BOOL* bElastic)

Gets the state of Elastic analysis option.

short Consolidation (VARIANT_BOOL* bConsolidation)

Gets the state of Consolidation analysis option.

short NumDisplacementData (short* sNumDispData)
Gets the number of displacement data entries in the current file.
short NumRectLoads (short* sNumRectLoads)

Gets the number of rectangular loads in the current file.

short NumCircLoads (short* sNumCircLoads)

Gets the number of circular loads in the current file.

short NumPolyLoads (short* sNumPolyLoads)

Gets the number of polygonal loads in the current file.

short NumDisplacementPoints (short* sNumDispPoints)

Gets the number of displacement points in the current file.

short NumDisplacementLines (short* sNumDispLines)

Gets the number of displacement lines in the current file.

short NumDisplacementGrids (short* SNumDispGrids)

Gets the number of displacement grids in the current file.

short NumPointsAlongLine (short sindex, short* sPoints)
Gets the number of points along the extrusion direction of the displacement line
identified with sindex.

sindex is a one based input.

short NumPointsAlongGrid (short sindex, short* sPoints)

Gets the number of points along the extrusion direction of the displacement grid
identified with sindex.
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sindex is a one based input.

short NumPointsAcrossGrid (short sindex, short* sPoints)

Gets the number of points across the extrusion direction of the displacement grid
identified with sindex.

sindex is a one based input.

short NumResults (short* sResults)

Gets the number of results.

short NumPointResults (short sindex, short* sResults)

Gets the number of results of the displacement point identified with sindex.

short NumLineResults (short sindex, short* sResults)

Gets the number of results of the displacement line identified with sindex.

short NumGridResults (short sindex, short* sResults)

Gets the number of results of the displacement grid identified with sindex.

short NumStrata (SHORT sIindexSoilProfile, SHORT* sNum Strata)

Gets the number of strata in the soil profile identified with sindexSoilProfile.
sindexSoilProfile is a one based input.

short NumSoilProfiles (SHORT* sNumSoilProfiles)

Gets the number of soil profiles in the current file.

short NumSoilZones (SHORT* sNumSoilZones)

Gets the number of soil zones in the current file.

short NumTimeSteps (short* sNumTimeSteps)

Gets the number of time steps.

short NumPolylines (short* sNumPolylines)

Gets the number of polylines in the current file.

short NumDisplacementPolylines (short* sSNumDispPolylines)
Gets the number of displacement polylines in the current file.

short GetDisplacementPoint(SHORT sindex, DisplacementPoint* dispPoint)
Gets the DisplacementPoint at sindex.

sindex is a one based input.

short GetDisplacementLine(SHORT sindex, DisplacementLine* dispLine)
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Gets the DisplacementLine at sindex.
sindex is a one based input.

short GetDisplacementGrid(SHORT slndex, DisplacementGrid* dispGrid)
Gets the DisplacementGrid at sindex.
sindex is a one based input.

short GetRectLoad(SHORT sIindex, RectLoad* rectLoad)
Gets the RectLoad at sindex.
sindex is a one based input.

short GetCircLoad(SHORT sIndex, CircLoad* circLoad)
Gets the CircLoad at sindex.
sindex is a one based input.

short GetPolyLoad(SHORT sindex, PolyLoad* polyLoad)
Gets the PolyLoad at sindex.

sindex is a one based input.

short GetStratum(SHORT sIndexProfile, SHORT sIndexStratum, PDispStratum*
stratum)

Gets the PDispStratum at sindexStraum of the soil profile identified with sindexProfile.
sindexProfile is a one based input.
sindexStratum is a one based input.
short GetRigidBoundaryLevel(DOUBLE* dValue)
Gets the Rigid Boundary Level.
short GetTimePeriod(DOUBLE* dValue)
Gets the time period over which the consolidation calculations are to be performed.
short GetTimeStep(DOUBLE* dValue)

Gets the interval at which the consolidation calculations are to be performed and their
results reported.

short GetWaterLevel(DOUBLE* dValue)

Gets the level of the water table.
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short GetWaterUnitWt(DOUBLE* dValue)
Gets the unit weight of water.

short GetPolyline(SHORT sIndex, Polyline* polyline)
Gets the Polyline at sindex.

sindex is a one based input.
short GetSoilZone (SHORT sIndex, SoilZone* zone)

Gets the SoilZone at sindex.
sindex is a one based input.

short GetDisplacementPolyline(SHORT slndex, DisplacementPolyline* dispPolyline)
Gets the DisplacementPolyline at sindex.
sindex is a one based input.

short SetDisplacementPoint(SHORT sindex, DisplacementPoint* dispPoint)
Sets the DisplacementPoint at sindex.
sindex is a one based input.

short SetDisplacementLine(SHORT sindex, DisplacementLine* dispLine)
Sets the DisplacementLine at sindex.
sindex is a one based input.

short SetDisplacementGrid(SHORT slndex, DisplacementGrid* dispGrid)
Sets the DisplacementGrid at sindex.

sindex is a one based input.
short SetSoilZone (SHORT sindex, SoilZone* soilzone)

Sets the SoilZone at sindex.
sindex is a one based input.

short SetElastic (VARIANT_BOOL bElastic)
Set elastic analysis to true or false.

short SetConsolidation (VARIANT_BOOL bConsolidation)

Set consolidation analysis to true or false.

Below is the VB code that illustrates how the above displacement functions can be called

© Oasys Ltd. 2019



Programming Interface 61

Dim pt As pdispauto_20_0. Di spl acement Poi nt
sResult = PdispObj.GetDi spl acement Point (1, pt)

pt. Name = "Point1"

pt. X = 10
pt.Y = 10
pt.Z =0

sResult = PdispObj. SetDi spl acenment Point (1, pt)
DimIn As pdispauto_20_0. Di spl acement Li ne
sResult = Pdi spObj. Get Di spl acenment Li ne(1, |n)

I n. Name = "Linel"
In.nlntervals = 10

sResult = Pdi spObj . SetDi spl acenentLine(1, In)

short SetRectLoad(SHORT sindex, RectLoad* rectLoad)
Sets the RectLoad at sindex.
sindex is a one based input.

short SetCircLoad(SHORT sIndex, CircLoad* circLoad)
Sets the CircLoad at sindex.
sindex is a one based input.

short SetPolyLoad(SHORT sindex, PolyLoad* polyLoad)
Sets the PolyLoad at sindex.
sindex is a one based input.

sindex is a one based input.

short SetStratum(SHORT sIndexProfile, SHORT sIndex Stratum, PDispStratum*
stratum)

Gets the PDispStratum at sindexStraum of the soil profile identified with sindexProfile.
sindexProfile is a one based input.

sindexStratum is a one based input.
short SetStrata (SHORT slndexProfile, SAFEARRAY(PDispStratum)* strata)

Sets the strata of Soil Profile identified with sindexProfile.
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short SetPolyline(SHORT sIndex, Polyline* polyline)
Sets the Polyline at sindex.
sindex is a one based input.

short SetDisplacementPolyline(SHORT sindex, DisplacementPolyline* dispPolyline)
Sets the DisplacementPolyline at sindex.

sindex is a one based input.

short SetTimePeriod(DOUBLE dValue)
Sets the time period owver which the consolidation calculations are to be performed.
short SetTimeStep(DOUBLE dValue)

Sets the interval at which the consolidation calculations are to be performed and their
results reported.

short SetRigidBoundaryLevel(DOUBLE dValue)
Sets the Rigid Boundary Lewel.
short SetWaterLevel(DOUBLE dValue)
Sets the level of the water table.
short SetWaterUnitWt(DOUBLE dValue)
Sets the unit weight of water.
short AddDisplacementPoint(DisplacementPoint* dispPoint)
Adds the DisplacementPoint.

Below is the VB code that illustrates how the above load functions can be called

Dimrl As pdispauto_20_0. Rect Load
sResult = Pdi spObj. Get RectLoad(1, rl)

rl.Nane = "Rect Loadl"
rl.Length = 10
rl.Orientation = Vertical

sResult = Pdi spObj. Set Rect Load(1, rl)
Dimcl As pdispauto_20_0.CirclLoad

sResult = PdispObj.GetCircLoad(1l, cl)
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cl.Nanme = "CircLoadl"
cl.Normal = 100
cl.Orientation = Vertical

sResult = PdispObj.SetCirclLoad(1l, cl)
Dim pl As pdispauto_20_0. Pol yLoad

sResult = Pdi spObj. GetPol yLoad(1, pl)

Di m pts(2) As pdispauto_20_0. Poi nt 2D

pts(0).X = -60

pts(0).Y = 60

pts(1).X = -60

pts(1).Y =0

pts(2).X = -40

pts(2).Y = 60

p. Coor = pts

p. Name = "Pol ygonal Load"

sResult = Pdi spObj . Set Pol yLoad(1, p)

short AddDisplacementPoint(DisplacementPoint* dispPoint)
Adds the DisplacementPoint.

short AddDisplacementLine(DisplacementLine* dispLine)
Adds the DisplacementLine.

short AddDisplacementGrid(DisplacementGrid* dispGrid)
Adds the DisplacementGrid.

short AddRectLoad(RectLoad* rectLoad)

Adds the RectLoad.
short AddCircLoad(CircLoad* circLoad)
Adds the CircLoad.
short AddPolyLoad(PolyLoad* polyLoad)
Adds the PolyLoad.
short AddStratum (SHORT slndexProfile, PDispStratum* stratum)
Adds the Stratum to soil profile identified with sindexProfile.
short AddSoilProfile (SAFEARRAY(PDispStratum)* strata)
Adds the Soil Profile (array of strata).Set

short AddSoilZone (SoilZone* soilzone)

63
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Adds the Soil Zone.

short AddPolyline(Polyline* polyline)
Adds the Polyline.

short AddDisplacementPolyline(DisplacementPolyline* dispPolyline)
Adds the DisplacementPolyline.

short DeleteDisplacementPoint(SHORT sIndex)
Deletes the DisplacementPoint at sindex.
sindex is a one based input.

short DeleteDisplacementLine(SHORT sIndex)
Deletes the DisplacementLine at sindex.
sindex is a one based input.

short DeleteDisplacementGrid(SHORT sIndex)
Deletes the DisplacementGrid at sindex.
sindex is a one based input.

short DeleteRectLoad(SHORT sindex)
Deletes the RectLoad at sindex.
sindex is a one based input.

short DeleteCircLoad(SHORT slndex)
Deletes the CircLoad at sindex.
sindex is a one based input.

short DeletePolyLoad(SHORT sindex)
Deletes the PolyLoad at sindex.
sindex is a one based input.

short DeleteSoilZone(SHORT sindex)

Deletes the SoilZone at sindex.
sindex is a one based input.

short DeleteStratum (SHORT sIindexProfile, SHORT sIndexStratum)

Deletes the PDispStratum at sindexStraum of the soil profile identified with
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sindexProfile.

sindex.

sindexProfile is a one based input.
sindexStratum is a one based input.

short DeletePolyline(SHORT sindex)
Deletes the Polyline at sindex.
sindex is a one based input.

short DeleteDisplacementPolyline(SHORT sIndex)
Deletes the DisplacementPolyline at sindex.
sindex is a one based input.

short GetBoussResult_RectLoad(SHORT sIindex, PdispBoussinesgResult* loadResult)
Gets the PdispBoussinesqResult object for the rectangular load identified with sindex.
sindex is a one based input.
This function is to be called if the analysis method chosen is Boussinesq.

short GetBoussResult_CircLoad(SHORT sIindex, PdispBoussinesgResult* loadResult)
Gets the PdispBoussinesqResult object for the circular load identified with sindex.
sindex is a one based input.
This function is to be called if the analysis method chosen is Boussinesq.

short GetBoussResult_PolyLoad(SHORT sindex, PdispBoussinesqResult* loadResult)
Gets the PdispBoussinesqResult object for the polygonal load identified with sindex.
sindex is a one based input.
This function is to be called if the analysis method chosen is Boussinesq.

short GetBoussResult_DispPoint(SHORT slndex, PdispBoussinesqResult* dispResult)

Gets the PdispBoussinesqResult object for the displacement point identified with

sindex is a one based input.

This function is to be called if the analysis method chosen is Boussinesq.
short GetMindlinResult_RectLoad(SHORT sIndex, PdispMindlinResult* loadResult)

Gets the PdispMindlinResult object for the rectangular load identified with sindex.
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sindex is a one based input.
This function is to be called if the analysis method chosen is Mindlin.

short GetMindlinResult_CircLoad(SHORT sIndex, PdispMindlinResult* loadResult)
Gets the PdispMindlinResult object for the circular load identified with sindex.
sindex is a one based input.
This function is to be called if the analysis method chosen is Mindlin.

short GetMindlinResult_PolyLoad(SHORT sIindex, PdispMindlinResult* loadResult)
Gets the PdispMindlinResult object for the polygonal load identified with sindex.
sindex is a one based input.
This function is to be called if the analysis method chosen is Mindlin.

short GetMindlinResult_DispPoint(SHORT sindex, PdispMindlinResult* dispResult)
Gets the PdispMindlinResult object for the displacement point identified with sindex.
sindex is a one based input.
This function is to be called if the analysis method chosen is Mindlin.

short GetBoussResults_RectLoad(SHORT slndex,
SAFEARRAY(PdispBoussinesqResult)* loadResults)

Gets the PdispBoussinesqResult object for the rectangular load identified with sindex.
sindex - index of the rectangular load. It is a one based input.

loadResults - SAFEARRAY of PdispBoussinesqResult objects for the rectangular load
identified with sindex.

This function is to be called if the analysis method chosen is Boussinesq.

short GetBoussResults_CircLoad(SHORT sindex, SAFEARRAY(PdispBoussinesgResult)
* loadResults)

Gets the PdispBoussinesqResult object for the circular load identified with sindex.
slndex - index of the circular load. It is a one based input.

loadResults - SAFEARRAY of PdispBoussinesqResult objects for the circular load
identified with sindex.

This function is to be called if the analysis method chosen is Boussinesq.

short GetBoussResults_PolyLoad(SHORT sIndex,
SAFEARRAY(PdispBoussinesqResult)* loadResults)
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Gets the PdispBoussinesqResult object for the polygonal load identified with sindex.
sindex - index of the polygonal load. It is a one based input.

loadResults - SAFEARRAY of PdispBoussinesqResult objects for the polygonal load
identified with sindex.

This function is to be called if the analysis method chosen is Boussinesq.

short GetBoussResults_DispPoint(SHORT slndex,
SAFEARRAY(PdispBoussinesgResult)* loadResults)

Gets the PdispBoussinesqResult object for the displacement point identified with
sindex.

sindex - index of the displacement point. It is a one based input.

loadResults - SAFEARRAY of PdispBoussinesgResult objects for the displacement
point identified with sindex.

This function is to be called if the analysis method chosen is Boussinesq.

short GetBoussResults DispLine(SHORT sIindex, SAFEARRAY(PdispBoussinesqResult)
* loadResults)

Gets the PdispBoussinesqResult object for the displacement line identified with sindex.
sindex - index of the displacement line. It is a one based input.

loadResults - SAFEARRAY of PdispBoussinesqResult objects for the displacement line
identified with sindex.

This function is to be called if the analysis method chosen is Boussinesq.

short GetBoussResults_DispGrid(SHORT sindex, SAFEARRAY(PdispBoussinesqResult)
* loadResults)

Gets the PdispBoussinesgResult object for the displacement grid identified with sindex.
slndex - index of the displacement grid. It is a one based input.

loadResults - SAFEARRAY of PdispBoussinesqResult objects for the displacement grid
identified with sindex.

This function is to be called if the analysis method chosen is Boussinesq.

short GetMindlinResults_RectLoad(SHORT sIndex,
SAFEARRAY(PdispBoussinesqResult)* loadResults)

Gets the PdispMindlinResult object for the rectangular load identified with sindex.
sindex - index of the rectangular load. It is a one based input.

loadResults - SAFEARRAY of PdispMindlinResult objects for the rectangular load
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identified with sindex.
This function is to be called if the analysis method chosen is Mindlin.

short GetMindlinResults_CircLoad(SHORT sIndex,
SAFEARRAY(PdispBoussinesqResult)* loadResults)

Gets the PdispMindlinResult object for the circular load identified with sindex.
sindex - index of the circular load. It is a one based input.

loadResults - SAFEARRAY of PdispMindlinResult objects for the circular load identified
with sindex.

This function is to be called if the analysis method chosen is Mindlin.

short GetMindlinResults_PolyLoad(SHORT sIindex,
SAFEARRAY(PdispBoussinesqResult)* loadResults)

Gets the PdispMindlinResult object for the polygonal load identified with sindex.
sindex - index of the polygonal load. It is a one based input.

loadResults - SAFEARRAY of PdispMindlinResult objects for the polygonal load
identified with sindex.

This function is to be called if the analysis method chosen is Mindlin.

short GetMindlinResults_DispPoint(SHORT sIndex,
SAFEARRAY(PdispBoussinesqResult)* loadResults)

Gets the PdispMindlinResult object for the displacement point identified with sindex.
sindex - index of the displacement point. It is a one based input.

loadResults - SAFEARRAY of PdispMindlinResult objects for the displacement point
identified with sindex.

This function is to be called if the analysis method chosen is Mindlin.

short GetMindlinResults_DispLine(SHORT sIindex,
SAFEARRAY(PdispBoussinesqResult)* loadResults)

Gets the PdispMindlinResult object for the displacement line identified with sindex.
sindex - index of the displacement line. It is a one based input.

loadResults - SAFEARRAY of PdispMindlinResult objects for the displacement line
identified with sindex.

This function is to be called if the analysis method chosen is Mindlin.

short GetMindlinResults_DispGrid(SHORT sindex,
SAFEARRAY(PdispBoussinesgResult)* loadResults)
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Gets the PdispMindlinResult object for the displacement grid identified with sindex.
sindex - index of the displacement grid. It is a one based input.

loadResults - SAFEARRAY of PdispMindlinResult objects for the displacement grid
identified with sindex.

This function is to be called if the analysis method chosen is Mindlin.

short GetConsolidationResult_Load(enum ELoad eLoadType, SHORT slndex, SHORT
sTimeStep, PDispConsolidationResult* loadResult)

Gets the PdispConsolidationResult object for the eLoadType load identified with sindex.

sTimeStep is the time step for which the result is accessed.
sindex is a one based input.

This function is to be called only for Consolidation problems.

short GetConsolidationResults_Load(enum ELoad eLoadType, SHORT sIndex,
SHORT sTimeStep, SAFEARRAY(PDispConsolidationResult)* loadResults)

Gets the PdispConsolidationResult object for the eLoadType load identified with sindex.
sindex - index of the eLoadType load. It is a one based input.

loadResults - SAFEARRAY of PDispConsolidationResult objects for the rectangular
load identified with sindex.

This function is to be called only for Consolidation problems.

short GetConsolidationResult_DispEntity(enum EDispEntity eDispType, SHORT
slndex, SHORT sAlong, SHORT sAcross, SHORT sTimeStep,
PDispConsolidationResult* dispResult)

Gets the PdispConsolidationResult object for the eDispType entity identified with sindex.

sTimeStep is the time step for which the result is accessed.
sindex is a one based input.

This function is to be called only for Consolidation problems.

short GetConsolidationResults_DispEntity(enum EDispEntity eDispType, SHORT
slndex, SHORT sAlong, SHORT sAcross, SHORT sTimeStep,
SAFEARRAY(PDispConsolidationResult)* dispResults)

Gets the PdispConsolidationResult object for the eDispType entity identified with sindex.
sindex - index of the eDispType entity. It is a one based input.

loadResults - SAFEARRAY of PDispConsolidationResult objects for the rectangular
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load identified with sindex.

This function is to be called only for Consolidation problems.

412 COMVBA Example

The following is an example VBA script to run Pdisp remotely. This script can be found in the Excel
file in the Samples folder shipped with the program.

Sub Test Pdi spCOM )
Di m Pdi spObj
Set Pdi spObj = CreateObject("pdi spauto_20_0. Application")

Di m Pdi spFil ePath As String

Di m sResult As | nteger

DimrFil eName As Range
W th Worksheets("Al p Auto")
Set rFileNane = .Cells(3, 3)
End Wth

Pdi spFil ePath = rFil eNanme. Text
sResult = Pdi spObj. Open(Pdi spFil ePat h)

'Del ete existing results
sResult = Pdi spObj.Del ete()

Di m nDi sps As | nteger
sResult = Pdi spObj . NunDi spl acenent Dat a( nDi sps)

"Perform Anal ysi s
sResult = Pdi spObj . Anal yse()

'Save file
sResult = Pdi spObj. SaveAs(PDi spFi | ePat h)

sResult = Pdi spObj.Close()

Set Pdi spObj = Not hi ng

End Sub

4.1.3 COM C++ Example

The following is an example C++ code to run Pdisp remotely.

bool RunOneFunction(
COleDispatchDriver* pDispDriver,
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}

CString csFuncName,
BYTE* pArgType,
CString csArgument,

SHORT* pShort)

DISPID dispid;

OLECHAR* pcsFunc;
CString csMsg;

int iReturn(0);

pcsFunc = csFuncName.AllocSysString();

//Find the function ID
if(pDispDriver->m_lpDispatch->GetIDsOfNames (

IID_NULL,
&pcsFunc,
1,
NULL,
&dispid) != S _0OK)
{
csMsg.Format(_T("Function (%s) cannot be found"),csFuncName);
AfxMessageBox(csMsg);
return false;
}

//Run the function
if(csArgument.IsEmpty())
pDispDriver->InvokeHelper(
dispid,
DISPATCH_METHOD,
VT 12,
&iReturn,
pArgType,
pShort);
else
pDispDriver->InvokeHelper(
dispid,
DISPATCH_METHOD,
VT 12,
&iReturn,
pArgType,
csArgument,
pShort);

if(iReturn != @)
return false;
else
return true;

void RunPdisp()

{

CoInitialize(NULL);
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COleDispatchDriver cPdispDispDriver;

BYTE pArgTypel[] = VTS_WBSTR VTS_PI2;
BYTE pArgType2[] = VTS_PI2;
CString csPathl1("D:\\Tests\\PDisp\\Auto\\Test.pdd");//Replace this

with the correct path and file location

CString csPath2("D:\\Tests\\PDisp\\Auto\\TestCopy2.pdd");//Replace

this with the correct path and file location

// Create an instance of the Alp class "Alp.Automation"
if(!cPdispDispDriver.CreateDispatch(_T("pdispauto_19 4.Application™")))
{
AfxMessageBox(
_T("Pdisp not found or not registered"));
return;

}

bool bStat(true);
SHORT sRet;
// Function Open
if(bStat)
bStat = RunOneFunction(&cPdispDispDriver,
_T("Open"),
pArgTypel,
csPathl, &sRet);
// Function Save

if(bStat)
bStat = RunOneFunction(&cPdispDispDriver,
_T("Save"),
pArgType2,
_T(""),
&sRet);

// Function SaveAs
if(bStat)
bStat = RunOneFunction(&cPdispDispDriver,
_T("SaveAs"),
pArgTypel,
csPath2,
&sRet);

// Function Close
if(bStat)
bStat = RunOneFunction(&cPdispDispDriver,
_T("Close"),
pArgType2,
T,
&sRet);

cAlpDispDriver.ReleaseDispatch();

CoUninitialize();
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4.1.4

Enums and Structs

Enum EOrientation

HORIZONTAL
VERTICAL

Enum EExtrusion

X
Y
Z

Enum EPrimaryMethod

Mv
Cc
None

Enum EOverConsolidation

PRECONSPRESS
OCR
OCM

Enum ELoad

RECTANGULAR
CIRCULAR
POLYGONAL

Enum EDispEntity

DISPLACEMENT_POINT
DISPLACEMENT_LINE
DISPLACEMENT_POLYLINE
DISPLACEMENT_GRID

Struct RectLoad

BSTR Name
double X

double Y

double Z

double Angle
double Width
double Length
double Normal
double TangentialX
double TangentialY
EOrientation Orientation

Struct CircLoad
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BSTR Name
double X

double Y

double Z

double Angle
double Width

int nNRectangles
double Normal
double TangentialX
double TangentialY
EOrientation Orientation

Struct Point2D

double X
double Y

Struct PolyLoad

BSTR Name

double Lewel

double Tolerance

int nNRectangles

double Normal

SAFEARRAY (struct Point2D) Coor

Struct Point3D

double X
double Y
double Z

Struct Polyline

BSTR Name;
SAFEARRAY (struct Point3D) Coor;

Struct DisplacementPoint

BSTR Name

double X

double Y

double Z

VARIANT_BOOL Calculate

Struct DisplacementLine

BSTR Name
double X1
double Y1
double Z1
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double X2

double Y2

double 22

int nintenals
VARIANT_BOOL Calculate

Struct DisplacementPolyline

BSTR Name

int iPolylineRef

int nintenvals
VARIANT_BOOL Calculate

Struct DisplacementGrid

BSTR Name

double X1

double Y1

double Z1

double X2

double Y2

double 72

int nintervalsAlong

double ExtrusionDistance
int nintenalsAcross
EExtrusion Extrusion
VARIANT_BOOL Calculate

Struct PdispMindlinResult

double X
double Y
double Z
double DispX
double DispY
double DispZ

Struct PdispBoussinesqResult

double X

double Y

double Z

double DispZ

double StressCalcLevel
double Stress

double SumPrincStress
double Strain

Struct PDispStratum
BSTR Name

double toplevel
int ndispLewvels
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double Etop

double EBottom
double PoissonsRatio
double Mv

double e0

double Cc

double Cr
EOwerConsolidation OverCons
double PreConsPress
double OCR

double OCM

double Cv

double UnitWeight
double Ca

double Cae

double k

Struct SoilZone

BSTR Name
double Xmin

double Xmax
double Ymin
double Ymax
int iProfile

Struct PDispConsolidationResult

BSTR NAme
double X

double Y

double Z

double u

double DegOfCons
double primary
double secondary
double total

Output
Analysis and Data Checking

Results can be obtained by selection of the Analysis menu:

Prior to analysis the program provides warning messages if applicable.

Note: The option to 'Delete Results' becomes active once the calculations have been completed.
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5.2 Text Output

Text Output is available from the View menu, the Gateway or the Pdisp Toolbar. This output may
include input data and results - if an analysis has been performed. The results are provided in both a
full and condensed tabular form. The lists of tabulated output can be highlighted and then copied to
the clipboard and pasted into most Windows type applications e.g. Word or Excel. The output can
also be directly exported to various text or HTML formats by selecting Export from the File menu.

RESULTS FOR GRI DS
Anal ysi s: Boussi nesq
A obal Poisson's ratio: 0.2

Ri gi d boundary | evel: -30.0
The maxi mum di spl acement difference between

Boussi nesq method = 168. 0mm and M ndlin nethod = 59. 17nmm
occurs at point X=16.00m Y=-39.00m Level -2.588n0D and is: 108.9mm

Type Locati on Di spl acement

X Y Z[ Level ] X Y z

[m [m [ mOD] [ [ i [ i
Loads 0. 5000 43.50 0.0 105. 8 -12.50 1.253
1. 000 -54.00 -2.000 117.1 -12.50 1.253
0.0 -6.000 -1.000 31.97 -12.50 1.253
Point 1 0.0 0.0 -10. 00 34.90 -12. 46 1.641
Point 2 0.0 4.000 -10. 00 36. 67 -14. 46 2.539
Point 3 0.0 8. 000 -10. 00 38.23 -15.96 3. 327
Point 4 0.0 12.00 -10. 00 38.16 -16.61 3.676
Gid 1 0.0 0.0 -10. 00 34.90 -12. 46 1.641
0.0 4.000 -10. 00 36. 67 -14. 46 2.539
0.0 8. 000 -10. 00 38.23 -15.96 3. 327
0.0 12.00 -10. 00 38.16 -16.61 3.676
0.0 16. 00 -10. 00 36.03 -16. 25 3.668
0.0 20. 00 -10. 00 33.12 -15.14 3.799
4.000 0.0 -10. 00 36.72 -10.72 2.827
4.000 4.000 -10. 00 37.66 -12.84 4.777
4.000 8. 000 -10. 00 38.50 -14.13 6. 645
4. 000 12. 00 -10. 00 38. 23 -14. 67 7.302
4.000 16. 00 -10. 00 36.18 -14.84 6. 865
4.000 20. 00 -10. 00 32.82 -14.52 6. 859

An asterisk "*" at the right of a row indicates that the coordinate's result includes an imported
displacement.

5.2.1 Full Text Output

The tabulated results listed below are available in the full output.

Type lists the type of location for the displacement co-ordinates, i.e. the centre of the loaded areas,
the points, lines and grids.
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Location provides the global co-ordinates for the displacement points (X Y, Z[level]) in metres.

Displacement calculation level provides the level of the grid and all intermediate displacement
levels

Displacement lists displacements at the displacement points and all intermediate displacement
levels. Displacement in mm. Positive displacement indicates settlement, negative indicates heave.

An asterisk "*" to the right of the 'Displacement’ columns indicates that the coordinate's result
includes an imported displacement.

For the Boussinesq solution only, and if the point does not include the results of an imported
displacement:

Stresses list the stress values at all stress calculation points and at the centre of each sub-layer, as
defined by the intermediate displacement levels.

For consolidation problems, stresses are calculated and reported even at the displacement
calculation levels.

Once selected the program will scroll through all the results before allowing access to the data.
For Consolidation problems,

u is the excess pore pressure

U is the degree of consolidation

TimeStep : No is the number of time step at which the consolidation results are reported
TimeStep: Value is the consolidation time at which the results are reported

primary is the primary consolidation

secondary is the secondary consolidation

5.2.2 Condensed Text Output

The tabular results listed below are available in the condensed output.

Type describes the type of location for the displacement co-ordinates, i.e. the centre of the loaded
areas, the points, lines and grids.

Location provides the global co-ordinates for the displacement points (X, Y and Z[lewel]).
Displacement lists displacement of the point resulting from the applied loading. Horizontal
displacements are given in Global X, Y directions. Positive Z displacements indicate settlement,

negative Z displacements indicate heawe.

An asterisk "*" to the right of the 'Displacement’' columns indicates that the coordinate's result
includes an imported displacement.
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5.3

53.1

5.3.2

5.3.21

5.3.2.2

5.3.2.3

Graphical Output

Graphical output is accessed via the View menu, the Gateway or the Pdisp Toolbar.

The graphics menu is available if any of the following windows is visible:
e Plan
¢ Cross section
e Graphical Input

This menu allows the use of templates to save specific types of graphical displays. It also allows the
user to display the load magnitudes, to annotate the grids, lines and points and to set an exact
scale for the display.

Label objects is only available for the cross section view.

Input is only available for the Graphical Input view.

Templates

The templates function is used as follows.

1. Set up the graphics view which you would like to repeat for other files in the future.

2. Select the 'Save as template' option and save the view with a specific file name.

3. To reload the template select the 'Load template' option.

4. To return to the original view when the graphics option is opened select "reset defaults”.
Plan View

Plots of the plan area of the problem can be created.

The graphical displays may be customised via menu commands or the following icons on the
toolbars.

Set Contour Interval

Intervals for contours shown in the Plan View can be set by selecting from the program's menu:
Graphics -> Grid results -> Set contour interval. The Interval dialog box will appear.

Set Exact Scale

Selection of Set Exact Scale allows you to set any required scale for the graphics. The chosen
scale will be maintained when the graphic is printed. The scale is set via the Specify Scaling dialog.

Line Displacements
This provides a plot of displacement versus distance along the defined displacement lines.
To reach the plots click the "Line Graph" button, then place the cursor over the line you wish to view

and click with the left button. The program then requests whether you wish to view the line number
available.
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This view shows only horizontal lines. The deflected shapes of inclined lines can be viewed on the 3D
graphical output.

If 'No' is selected then the program will go to any lines below the area and ask again. This allows
you to view lines which are superimposed at different levels.

5.3.24 Soil Column Displacements

This view provides the displacement profile along a vertical line under the user specified point.
Displacement is plotted against level or depth according to the user's choice.

To view the graph click the "Soil Column Displacements” item in the Gateway, or select "View | Soil
Column Displacements™ on the program menu. A dialog box will pop up which asks for the plot data.

Enter the coordinates of the point under which the displacement profile is to be generated, and the
parameter against which displacement is to be plotted i.e. level or depth..

Press the "OK" button to view the graph.

The different soil layers of the zone in which the point lies are represented as coloured rectangles in
the graph.

The coordinates and the parameter against which the displacement should be plotted can be
changed \ia the dialog bar at the top of the view.

Select the "Apply" button to view the graph.
5.3.3 Cross Section Plot
This provides a plot of the generalised cross-section through the problem.

The section is not at any particular location and merely provides an illustration of the location of all
the input information which has both line and level.

5.3.3.1 Label objects

This option from the "Graphics” menu allows the user to label the Grids, Lines and Points with their
appropriate numbers and the Loads with their assigned values.

5.3.4 3D Graphical Output

The 3D Graphical Output displays a three dimensional plot of the model and its available results.
This entities and labels that are to be displaced are defined in the Graphic Settings property sheet
The orientation of the model in the view is controlled \via rotation, zooming and panning as described
below, and via buttons on the 3D Graphics toolbar which select the x, y or z elevation, perspective
mode and zooming to the extent of model data.

Rotate

The model can be rotated by pressing and holding the left mouse button and dragging the mouse.
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5341

Horizontal drag rotates the model with respect to its Z axis. Vertical drag rotates the model with
respect to the axis parallel to a horizontal line through the centre of the view.

Zoom

The model can be zoomed in or out by scrolling the mouse wheel. The model can be zoomed to its
original scale by pressing 'z' from keyboard.

Pan

The model can be panned by holding 'shift + left-click' and dragging the mouse. Panning is effective
for the orthogonal view.

Saving the view

The view point and zoom factor can be saved by selecting "Save default view settings" from the
context menu of the view. The context menu is accessible by right-clicking in the view or by using
the context menu key on the keyboard).

Printing

The view can be printed. The print may differ slightly from the image viewed on screen owing to
differing resolutions.

Graphic Settings

The Graphic Settings property sheet allows the parameters that govern the format and content of 3D
Graphical Ourtput View to be specified.

These graphic settings are stored in the data file. Default settings are provided by the program. The
defaults can be restored by clicking the ‘Restore Defaults’ button. The 'Apply’ button applies the
settings to the 3D Graphics view.

This property sheet may be accessed via:

¢ "Data | Graphic Settings" from the program’'s main menu; or

e the Wizard button % on the Pdisp Toolbar when the 3D Graphics Output is active; or

¢ selecting "Graphic settings" from the context menu of the 3D Graphics Output (the context menu
is accessible by right-clicking in the view or typing the context menu key from keyboard); or

¢ the Gateway, by selecting "Output | 3D Graphics".

The controls are separated into four different pages:

Sail

Loads
Displacements
Preferences

Each of these is described in detail below.

Soil zones and labelling
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This section specifies which soil zones are to be displayed, and, if displayed, which should be
labelled.

Soil profiles

This section specifies how soil profiles are to be displayed.

Solid display

If this is selected soil profiles will be displayed as solid surfaces with their respective strata colours
as specified in the Soil Profiles table. Solid display does not allow the display of loads or
displacements.

Wire frame display

If this is selected soil profiles are displayed as a wire frame. Wire frame display allows the display of
loads and displacements.

Soil zones display

This selection chooses which soil zones are to be displayed. The list shows those soil zones that
have been defined in the Soil Zones table. It allows multi-selection.

All
This button causes all the soil zones to be selected.

None
This button clears the selection of soil zones.

Annotation

When this is checked all displayed zones are given labels on the 3D Graphics view.

Loads

This specifies which loads are to be displayed.

All the controls from this page are enabled only when the 'Wire frame display' button is selected in
the Soil page -> 'Soil profiles' section.

Loads and labelling

This section specifies which loads are to be displayed, and, if displayed, which should be labelled.
Load intensity can be viewed in two ways.

Loaded areas

Each different load intensity, as specified in the Load Data table, is displayed with a different colour.
A legend of colour vs load intensity will be displayed. Load orientation i.e. normal, tangential x and

tangential y can be selected from the drop down list.

Loads as arrows
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All loads associated with a loaded plane are viewed at once as arrows. The values of intensity will be
displayed at the tip of each arrow. Arrow size based on intensity allows the arrow length to be
scaled according to the size of the load. The scale can be doubled or halved by clicking the "x2" or
"[2" buttons.

Displacements

The Displacements' page specifies how the displacement input data and results are to be displayed.

The components of this page are enabled only when the 'Wire frame display' option is selected in the
'Soil profiles' section.

After performing an analysis, results are available for the Points, Lines and Grids specified in the
Displacement Data table. The 3D Graphics View can illustrate these results. If no results are
available then only the undeflected locations of the proposed displacement data are available for
display.

Displacement data and labelling

This section specifies which displacement entities are to be displayed, and, if displayed, which
should be labelled.

Grids

Filled polygons

When this is checked the deflected nodes on a grid form a surface with filled polygons. When
unchecked it displays polygons by outlines. This button is enabled only if results exist and when the
‘Contour surface' button is unchecked.

Contour surface

This selection allows display of line contours, filled contours or no contours. Contours are displayed
with an interval specified in the 'Contour interval' edit box. This represents the deflection pattern on a
grid. This contour surface is drawn on an undeflected grid. This is enabled only if results exist.
Contour interval

The value of the contour interval is automatically initialised with a default value based on the
minimum and maximum extents of the deflection results. The contour surface can be viewed at
another contour internval by changing this value. The minimum value that is required is such as to
limit the number of contours to less than 50. The maximum value is the contour range.

Direction

The component of displacement in the X, Y and Z directions, or the resultant displacement, may be
chosen for display. The contour surface or deflected shape will be based on this selection.

Display nodes

When this is checked the nodes on the grid will be highlighted with a small cube. This is helpful to
identify nodes on a deflected surface when the 'Filled polygons' button is unchecked.
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Display values

When this is checked the nodes will be annotated with displacement values. This button is enabled
only if results exist.

Undeflected/Deflected shape

When this is checked the undeflected positions of Points, Lines and Grids are displayed. This is
required to view the locations of displacement entities when there are no results.

General

Centre of rotation

This specifies the co-ordinate of the centre for rotating and zooming.

Centre of drawing

When this is selected the centre of rotation is set to the centre of the model, the resulting Xand Y
co-ordinates are displayed in the edit boxes. These cannot be edited directly.

Custom

When this is selected the edit boxes Xand Y are enabled so that the centre of rotation may be
entered directly.

Labels

Name

Indicates that labels, where specified, are to display the names of entities only.
No.

Indicates that labels are to display the reference numbers of entities only.
No.:Name

Indicates that labels, where specified, are to display both the names and numbers of entities.

Transparent

When this is checked the surfaces become semi-transparent. The transparency depends on the
sequence of the drawing order.

Lighting

When this is checked light falls on the model from a pre-defined position set by the program. This
button is enabled only when lighting is appropriate.
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5.4

Picture area to exclude legend panel

When this is checked the picture area used for the legend is used exclusively for the legend and that
used for the display of the image is reduced by the width of the legend panel. Otherwise the legend
is superimposed on the image.

Perspective view

Toggles the view between orthogonal and perspective.

Defaults

This resets all the settings to the program's defaults and applies them to the 3D Graphics View.
OK

This applies to the 3D Graphics View the current settings from all the pages, and closes the property
sheet.

Undo

This undoes the changes to all those pages that have been modified since the ‘Apply' button was last
pressed.

Apply

This applies to the 3D Graphics View the current settings from all the pages without exiting the
property sheet.

Chart Output

Chart outputs can be directly accessed from the output explorer.
Following are the chart outputs that the program provides:
1) Displacement vs Time
2) Displacement Lines
e Settlement
e Stress

e Strain

3) Soail Column Displacements
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5.4.1 Displacementvs Time

This is active only for consolidation problems. It shows the displacements at various time steps.

The user can select a particular displacement point or a point of any of the lines and grids by using
the drop lists provided.

Q ConsclidationLayered.pdd : Displacement vs Time Charts E@
Displacement Data  Line Ref: Name  1: Line 1 Paint |[-10 000, 0.000, 0.000) \/l +
Displacement for (-10.000,0.000,0.000) == Immediate

—=— Primary Consclidation
Secondary Settlement

—=— Total

-100.

=150,

-200.

-250.

Displacement [mm]

-300.

-350.

-400.

Time Step (years)

5.4.2 DisplacementLines

Following charts for can be viewed for displacement lines.

e Settlement
e Stress
e Strain

5.4.2.1 Displacements
This provides a plot of displacements versus distance along the defined displacement lines.
The type of displacement (immediate or consolidation or total) can be selected from the drop down

provided. The time step at which the consolidation is to be viewed can also be selected from the drop
down provided,
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Displacement Line  1: Line 1

@ ConsolidationLayered.pdd : Displacement Line - Chart

Displacement | Total (werical] v - Time Step (1055

[o ==

o]+ =

Displacement for Line 1

=== Total

ADisplacgment [rmim]
o e}
o =3

=}
=4

-410.

Distance from (-10,0) inm

5.4.2.2 Stress

This provides a plot of stress versus distance along the defined displacement lines. This is active

only for Boussinesq.

M PdispMan.pdd : Displacement Line - Chart

= o=

Displacement Line |1 Line 1

~|+

Displacement for Line 1

=

—F— Stress

140, 160. 180,

B
5 8

=)
o

stress [kN/m?)

Distance from (-70,-80) inm
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54.2.3

5.4.3

5431

Strain

This provides a plot of stress versus distance along the defined displacement lines. This is active
only for Boussinesq.

L=| PdispMan.pdd : Displacement Line - Chart oo ==

Displacement Line [1: Line 1 ~]+

Strain for Line 1
" Sfrain

-500.E-6

500.6-6

0.001

o
trai@le]
o

ooz

0.0025

0.003

0.0035

0.004

Distance from (-70,-80) in m

Displacement Polylines

Following charts for can be viewed for displacement polylines.

e Settlement
e Stress
e Strain

Displacements
This provides a plot of displacements versus distance along the defined displacement polylines.
The type of displacement (immediate or consolidation or total) can be selected from the drop down

provided. The time step at which the consolidation is to be viewed can also be selected from the drop
down provided,
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M DisplacementPolylinesTest_Conselidation.pdd : Displacement Polyline - Chart

Dizplacement | Total [vertical] -

Dizplacement Line  1: Dizplacement Palyline 1

(o] s
Time Step (140«

Displacement for Displacement Polyline 1

== Total

1p. 13. 2.

BLisplacgment [hrm] & U
[=) w w [=s]
=1 [ =1 ]

=)
[

Chainage (from start of displacement polyline) m

5.4.3.2 Stress

This provides a plot of stress versus distance along the defined displacement polylines. This is active

only for Boussinesq.

Chainage (from start of displacement polyline) m

M DisplacementPolylinesTest_Censelidation.pdd : Displacement Polyline - Chart EIIEI
' Dizplacement Paluline 1 Dizplacement Falyline 1
Stress for Displacement Polyline 1
—F— Siress
100,

E

=

Z

=

g

]

94, y ¥ t y T T T v T !
0 2. 4, 6. 8. 10. 12, 14, 16. 18, 20.
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5.4.3.3

5.4.4

5.5

Strain

This provides a plot of stress versus distance along the defined displacement polylines. This is active
only for Boussinesq.

M DisplacementPolylinesTest_Consolidation.pdd : Displacement Polyline - Chart EI@

Dizplacement Palyline  1: Dizplacement Palyline 1

Strain for Displacement Polyline 1
—%— Strain

0.005

Strain [£]

0 2. 4 . 8. 10. 12, 14, 16. 18, 20.
Chainage (from start of displacement polyline) m

Soil Column Displacements

This view provides the displacement profile along a vertical line under the user specified point.
Displacement is plotted against level or depth according to the user's choice.

CSV Results File

A comma-separated value (CSV) file of results may be output by selecting 'File | Export | CSV
Results File ..." on the program menu. This option is disabled if there are no results, so an analysis
must have first been performed. On selection of that option the CSV Results Export dialog will
appear. This allows the specification of which results are to be written.

The CSV output file may contain any of the following:

e grid, line and point displacements;
e as appropriate to the analysis method, alignments of contours of displacements in the x, y, z or
resultant direction, and stresses (vertical and sum principal) and vertical strain.

One purpose of this output is to allow building damage segments/categories and displacement
contours to be plotted on drawings in other design programs e.g. AutoCAD.

In the case of displacement results, the CSV Results Export dialog allows the choice of whether
locations that are duplicates of those that have already been written are to be ignored. If the "Skip
duplicate locations" option is checked, then a tolerance may be specified which is used to determine
whether two locations are considered to be duplicates. The tolerance specifies the maximum
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distance within which locations are deemed to be duplicates. If a point is found to be a duplicate of a
location already written written, then it will be ignored, and only the first location and its results
written.

For example, if Displacement Line 1 ends at coordinates (10,10,10), and Displacement Line 2 begins
at coordinates (10,10,10), then choosing "Skip duplicate locations" will ensure the location and
results at (10,10,10) are written to the CSV file only once.

If a grid is selected for a direction that contains results that are all zero, then that direction will be
disabled for the export of contour results.

The output file includes keywords to identify the content of each row of data. Samples are given
below which show the format.

Grid, line and point displacements follow the sequence: Keyword,x Coordinate,y Coordinate,z
Coordinate,x Displacement,y Displacement,z Displacement.

Contour data lines follow the sequence: Keyword,Grid No.,Contour value,x Coordinate 1,y Coordinate
1,x Coordinate 2,y Coordinate 2. They describe discrete segments of a contour line.

Dimensions for output data are chosen by the user in the "Save As" dialog that follows the "CSV
Results File Output Selection" dialog. Length and displacement units' indices are: 0 - metres; 1 -
centimetres; 2 - millimetres; 3 - feet; 4 - inches.

Units information should appear in the file before the results.

e.g.

Dl SP, 2

LENGTH, 0

CONTOUR_RESULTANT, 1, 10., 30., 22. 94968, 27. 96293, 23. 98147
CONTOUR_RESULTANT, 1, 10., 27. 96293, 23. 98147, 26. 13617, 25.
CONTOUR_RESULTANT, 1, 10., 26. 13617, 25., 23. 26587, 26. 63294

CONTOUR X, 1, - 60. , 90. , 80. 55464, 89. 26049, 80. 36975
CONTOUR X, 1. - 60. , 89. 26049, 80. 36975, 88. 89082, 80.
CONTOUR X, 1. - 60. , 95. 56882, 75. , 91. 57434, 74. 21283

Cd\ITQJR_Y, 1,-60.,48. 88889, 80., 49. 25906, 79. 62953
CONTOURLY, 1, - 60., 49. 25906, 79. 62953, 50., 79. 4441
CONTOURLY, 1, -60., 49. 77666, 85., 49. 81781, 84. 90891

CONTOUR Z, 1, 0., 50., 0. 4412712, 48. 84946, 0. 5752676
CONTOUR Z, 1, 0., 48. 84946, 0. 5752676, 43. 20705, 0.
CONTOUR Z, 1, 0., 60. , 0. 3418683, 59. 22948, 0. 3852612

GPO NT_RESULT, 150. , 240. ,-25.,0.,0.,-1. e- 003
GPOl NT_RESULT, 150. | 250. , - 25..0..0..-1. e- 003

LPOI NT_RESULT, 50. , 150. , 0., 0. 4636086, 0., 0. 3708869
LPOI NT_RESULT, 51. , 150. , 0. . 0. 6526436, 0. , 0. 5438696

PO NT_RESULT, 5., 150. , 0., 0. 9029427, 0., 0. 7851676
PO NT_RESULT, 55. , 150., 0., 1. 227543, 0. . 1. 115948
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5.6

Old Data File Version

Pdisp files may be read by Oasys GSA in order to perform raft analysis. However, GSA may not be
able to read Pdisp data files that have been written by the current version of Pdisp if this version of
Pdisp has been released after the current version of GSA. In such situations it may be useful to
export Pdisp data files in the earlier format that can be read by GSA, although some data may then

be lost if recently added data cannot be converted to the earlier format.

To export a Pdisp data file in an earlier GSA-compatible format choose "File -> Export -> Old
Version..." from the program menu.

Miscellaneous

Keyboard Accelerators

Key

Ctrl+Num 1
Ctrl+Num 2
Ctrl+Num 3
Ctrl+Num 4

Ctrl+Num 5
Ctrl+Num 6
Ctrl+Num 7
Ctrl+Num 8
Ctrl+Num 9
Ctrl+C
Ctrl+F
Ctrl+G
Ctrl+H
Ctrl+M
Ctrl+N
Ctrl+O
Ctrl+P
Ctrl+S
Ctrl+Shft+S
Ctrl+Vv
Ctrl+W
Ctrl+X

F1

Esc

Action

Window bottom-left
Window bottom
Window bottom-right
Window left

Window middle (full)
Window right
Window top-left
Window top
Window top-right
Copy

Find

Go To

Replace

Modify

New

Open

Print

Sawe

Sawe As

Paste

Wizard

Cut

Context Help

Quit
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6.2

Tab Next Cell

Return Next Cell

Insert Insert

Delete Delete

Home Beginning of Cell
Ctrl+Home Beginning of Table
End End of Cell
Ctrl+End End of Table
Page Up Scroll up

Page Down Scroll down

tUp Row Up

«—Lft Column Left
—Rt Column Right
1Dn Row Down
File Backups

A file backup results in a temporary copy of the model (input data and results) being saved in the
user's temporary folder (i.e. C:\Users\<username>\AppData\Local\Temp).

Backups may be manual backups, timed backups, or backups before and after analysis.

Manual backups have "_M.xdd" appended to the file name. Timed backups and backups before and
after analysis have "_bak" appended to the file name.

A manual backup of the data file is created automatically on opening a file.

A timed backup of the model is created periodically according to the user's preferences for timed
backups. Those preferences are reached via Tools -> Preferences from the program menu, where
the option to save timed backups may be set along with a backup interval.

A backup is also made automatically on beginning an analysis (so with no results) and on
completion of a successful analysis (so with results).

If a model has results then no timed backup is made since, if the file is unchanged since opening
there is no need, and if the file has been changed then an analysis must have been performed to
create those results, so a backup will have already been created on completion of the analysis.

If the program shuts down prematurely (as a result of program malfunction or power failure etc.) then
the backup files remain on disk for subsequent use if recent changes were not saved by the user and
so have otherwise been lost. The user may delete such backup files manually from their temporary
folder when they are no longer needed. They will, howewer, be overwritten if a data file with the same
name is opened, so their previous contents will be lost.

All instances of a model's backup files are automatically deleted when the data file is closed
properly.
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7.1

7.2

Toolbars

Toolbars provide a short cut to the more commonly used commands. Toolbars except can be docked
(attached to the application frame) or floating (free to be positioned by the user). The toolbars can be

switched on and off as required from the “View | Toolbars” menu command.

Standard Toolbar

The Standard Toolbar provides access to the following common Windows functions along with some

that are specific to the program.

Standard x

12k ¥ A e o o

New — create a new model
Open — open an existing file
Sawe — sawe the model to file

Cut — cut the data and place on clipboard
Copy — copy the data and place on the clipboard
Paste — paste the data from the clipboard into the model

Print — print the current view
Print Preview — preview the current view

About — opens the program's About Dialog e.g. to show version information
PDisp Home — opens the programs home page on the internet
Email — opens an email to the Oasys support team

~ Undo any change in the table view

. Redo any change in the table view

PDisp Toolbar

The PDisp Toolbar provides access to the following functions.

PDisp x
k2 «F Al|s0% -l % 2 X

= - open or close the Gateway
4J - open the 3D Graphics View
=] - open the Text Output View
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MM

specify a custom font scale to size text in the Plan View, or when printing the Text Output
(dependent on which of those views is active)

select from a list of font scales to size text as abowe

open the context sensitive wizard

perform an analysis
delete the results

7.3 Plan Toolbar

The following graphical displays are available for the Plan View and can be displayed or hidden by
toggling the individual icons on the Plan Toolbar or Graphics Menu.

Plan

(] R 5 [O]< N[0l [R] EARA 29 16

x

bmp

H

o
o

&
E1 "4

AXxis - Provides an axis and defined grid upon which the plan is drawn.

Engineering Scale - This allows the user to toggle between the default 'best fit' scale
and the closest available engineering scale. e.g. 1:200, 1:250, 1:500, 1:1000, 1:1250,
1:2500.

Save Metafile: Sawe icon allows the file to be sawe in the format of a Windows
Metafile. This retains the viewed scale. The metafile can be imported into other
programs such as a word processor, spreadsheets and drawing packages.

Inserting Bitmaps: Allows a bitmap to be placed behind the main graphical view, see
Inserting Bitmaps.

Zoom Facility - The user can select an area to 'zoom in' to by using the mouse to
click on a point on the drawing and then dragging the box outwards to select the area
to be viewed. The program will automatically scale the new view. The original area can
be restored by clicking on the ‘restore zoom' icon as shown here.

Edit Colours - The user can edit the colours of lines in the Plan View.

Soil Zones: Plots the extent of the soil zones.
Points - Toggles the display of displacement points.

Lines - Toggles the display of displacement lines.
The plan view shows only horizontal lines. Inclined lines can be viewed on the 3D
graphical output.

Grids - Toggles the display of displacement grids.

The plan view shows only horizontal grids. Inclined grids can be viewed on the 3D
graphical output.

Imported Displacements: Plots the locations of imported displacement points.

Loaded Areas: Plots the locations and sizes of the defined loaded areas. The plan
view shows only normal (vertical) loads on horizontal planes, with no rotation in plan.
Contours: The plan view shows contours (line contours or filled contours) for only
vertical displacements. Contours for horizontal, vertical and resultant displacements
can be viewed on 3D graphical output.
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Annotation: Selection of this button allows the use of the mouse to place the value of
settlement at the exact location of the cursor and at the lewvel of the displacement grid
selected. Not the closest contour value.

To operate place the cursor over the required location and press return or the left
button on the mouse.

Tip: If a displacement line is in the vicinity of a point you wish to annotate then de-
select the displacement grids icon and proceed with the annotation. To get the
maximum accuracy for the location of the points maximise the size of the screen and
scale of working.

Change Displacement Grids: The user can mowve up or down to the data defined for
the different displacement grid levels. The number of the level currently being viewed is
given at the top of the figure.

Line Graphs - Allows the user to plot the displacements along the selected
displacement line, building damage results for the selected building, or utility damage
results for the selected utility.

3D Graphics Toolbar

The 3D Graphics Menu and Toolbar provide rapid access to the functions to control the 3D Graphics
View display. Greater control is possible via the 3D Graphics Settings wizard. For instance, the
settings wizard allows individual displacement lines to be viewed or hidden, whereas the toolbar
allows only the display of all or none.

3D Graphics

_ x
O SB[& R B s 28 1% vl iz 5= <

H

& -

Rectangular
Circular
Polygonal

Toggles the display of all soil zones.

Toggles the display of all displacement points.

Toggles the display of all displacement lines.

Toggles the display of all displacement grids.

Toggles the display of all loads.
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Harizantal

Resultant

Z - Elastic

Z-Total
Stress - Vertical

Stress - Sum Principal

Strain - Vertical

- -
Horizontal

Resultant

7 - Elastic

Z - Cons. - Primary

Z -Total
Stress - Vertical
Stress - Sum Principal

Strain - Vertical

S - -
Horizontal
Resuftant
x
]
Z-Elastic
Z-Cons, - Primary
7. Cons. - Secondary

Z-Cons. - Total

Z-Total

a3

Toggles the display of all labels.

Toggles the display of line contours for Displacement Grids (clicking the button
toggles contours of Z displacement, clicking the drop arrow on the right of the button
allows more specific selection).™!

Toggles the display of filled contours for Displacement Grids (clicking the button
toggles contours of Z displacement, clicking the drop arrow on the right of the button
allows more specific selection).!!

Toggles the display of the deflected shape of Displacement Data (clicking the button
toggles deflected shape based on Z displacement, clicking the drop arrow on the
right of the button allows more specific selection).[

Toggles the display of displacement values for Displacement Data locations (values
are sensitive to which results are currently being displayed, or, if none, will show
values for Z displacement).

Orientates the view so as to be looking down the X axis.

Orientates the view so as to be looking down the Y axis.

Orientates the view so as to be looking down the Z axis (i.e. a plan view).

Orientates the view so as to be viewing an isometric view.

Toggles the display of the model in perspective mode.
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+h - Re-sizes the view so as to be scaled to fit the available window size (when in
graphical input mode it also resizes the grid if extents are not locked).
il - Toggles the display of the model in wire frame mode.
i - Toggles the display of nodes for Displacement Data.
] - Toggles the display of the model in transparency mode.
{ - Toggles lighting on or off.
Notes
[1] Grids must first be \isible, by selecting Displacement Data button to toggle Displacement
Grids, before line contours, filled contours or the deflected shape of Displacement Grids can
be shown.
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Brief Technical Description
PDisp

PDisp Pressure Induced Displacement Analysis

PDisp is a program which can calculate the displacements (and stresses if required) within a linear
elastic or non-linear soil mass, arising from uniform normal or tangential pressure, applied to
rectangular and circular loaded planes.

The ground is represented as a series of soil profiles. These are located in plan by using designated
areas known as soil zones.

Loads are completely flexible. Pressures are applied as vertically and/or horizontally and uniformly
distributed loads to rectangular and/or circular loaded areas. No allowance is made for the stiffness
of the structures.

Displacements can be calculated both beneath and adjacent to the applied loads. Horizontal and
vertical displacements can be calculated by choosing the Mindlin method. Vertical displacements
and stresses can be calculated by choosing Boussinesg method.

Vertical displacements (settlement and heave) are calculated relative to a rigid base, using one of
two approaches: Boussinesq and Mindlin.

In the Boussinesq method the stress distribution is correct for a uniform isotropic, elastic material
having a constant Poisson's ratio (which must be specified). Vertical strains are derived from this
stress distribution using the elastic constants appropriate to that strain level for each soil layer and
then summed to give displacements.

In the Mindlin method relative displacements across each soil layer are calculated directly as if the
whole of the ground had the same elastic properties as the layer concerned. The relative
displacements are then summed to give total displacements.

The Mindlin approach is more accurate, but the Boussinesq method allows non-linear soil properties
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and is relatively accurate if sufficient sub-layers (intermediate displacement levels) are used.

The sides of all soil zones are parallel to the Cartesian co-ordinate axes.

10 Manual Example
10.1 General

The data input and results for the PDisp manual are available in the 'Samples' sub-folder of the
program installation folder. The example has been created to show the data input for all aspects of
the program and does not seek to provide any indication of engineering advice.

Screen captures from this example have also been used throughout this document.

This example can be used by new users to practise data entry and become familiar with the details
of the program.
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Horizontal displacements
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